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Using Toolbars and Tool Palettes

FlowCharter 2000 Professional uses toolbars and tool palettes to 
provide much of its functionality. Toolbars contain icons that provid
set of related tools. For example, the Formatting toolbar contains t
for formatting elements of the diagram or model. With Tool palette
you can select from a palette of styles or colors. For example, the
an Arrowheads tool palette for selecting the direction of an arrow 
style of an arrowhead. There are color palettes for text, lines, and

You can display the following toolbars:

• Standard
• Formatting
• Toolbox
• Draw
• Preset Styles
• Custom Data
• iDiagram
• Visual Basic
• Connector Line Tool
• Zoom
• Controls
• Arrange
• Model
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• Trace

Note
The Trace toolbar is available only if you install iGrafx Process 2000.

Standard Toolbar

The Standard toolbar contains tools that help you perform basic 
functions in FlowCharter 2000 Professional. Most of these functio
appear as commands in the File and Edit menus.

Tool Command Description

New Creates a new diagram.

Open Opens a previously existing diagram.

Save Saves the active diagram.

Print Prints the active diagram.

Print 
Preview

Shows the diagram as it looks when you print
it.

Spelling Checks the spelling of text in your diagram.

Cut Removes the selected item and places it on t
Clipboard.
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Copy Copies the selected item and places it on the
Clipboard.

Paste Places the contents of the Clipboard on the 
diagram.

Format 
Painter

Copies the formatting of the selected text, 
shapes, or lines to other text, shapes, or lines

Undo Undoes an action or change.

Redo Reverses the last undo you made.

View 
Shape 
Palettes

Shows or hides the Shape palette.

Draw Opens the Draw Toolbar.

Properties Opens the Properties dialog box.

Zoom 
Control

Magnifies the diagram by the percentage you
select or enter.

Help Opens the FlowCharter 2000 Professional 
HTML Help system.
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Formatting Toolbar

The Formatting toolbar gives you easy access to the options you u
define the way text, lines, and shapes look in your diagrams. 
Additional formatting options are available on the Format menu.

Tool Command Description

Font 
Name

Displays and changes the name of the 
current font. 

Font Size Shows the current point size.

Bold Turns text bold (or removes bold, if it is
already bold).

Italic Turns text italic (or removes italic, if it 
is already italic).

Underline Underlines text (or removes underline,
if it is already underlined).

Opaque Makes the text’s background opaque.

Text Color Applies color to text.

Vertical 
Align

Specifies Top, Middle, or Bottom 
alignment. Click the tool and then 
choose from the menu.

Horizontal 
Align

Specifies Left, Center, or Right 
alignment. Click the tool and then 
choose from the menu.
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Insert 
Field

Inserts a new field into a shape.

Bullets Makes selected text a bulleted list.

Decrease 
Indent

Moves paragraph to the left.

Increase 
Indent

Moves paragraph to the right.

Increase 
Line 
Spacing

Increases line spacing in selected text.

Decrease 
Line 
Spacing

Decreases line spacing in selected text

Rotate 
Text Left

Rotates text 90 degrees to the left.

Rotate 
Text Right

Rotates text 90 degrees to the right.
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Tips
You also can use the commands on the Format menu to specify 
formats, text color, fill color, line color, line styles, line weight, styles 
for filled lines, arrowhead styles, crossover styles, shadows, and 3D 
effects.

There are also shortcut keys for vertically aligning shapes: Top 
(CTRL+SHIFT+4), Middle (CTRL+SHIFT+6), Bottom 
(CTRL+SHIFT+8).

There are also shortcut keys for horizontally aligning shapes: Left 
(CTRL+SHIFT+3), Center (CTRL+SHIFT+5), Right 
(CTRL+SHIFT+7).

When you click the down arrow next to a color tool, a palette of colors
opens. If you click a color, the program applies it to the next shape or
currently selected shapes. To set a custom color, click More Colors, 
and the Color dialog box opens.
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Toolbox Toolbar

The Toolbox toolbar gives you easy access to the tools you use mo
create and change diagrams.

Tool Command Description

Selector Selects, moves, and resizes drawn 
elements.

Insert 
Department

Adds, edits, or deletes department 
attributes.

Shapes Places shapes in a diagram and selects
shape attributes and properties. Click the
arrow under the shape to select more 
shapes from the Shape Library.

You can use different shapes to represen
steps, documents, events, and other 
information in diagrams.

Connector 
Line

Connects shapes with different types of 
lines. Choose from Direct, Right Angle, 
Curved, Org Chart, Cause and Effect, and
Lightning Bolt lines.

Text Enters and changes text, types text block
types text on lines, and changes text. (It i
not necessary to select the Text tool to ad
text to a selected shape.)
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Draw Toolbar

The Draw toolbar contains tools that align, flip, rotate, reorder, 
replace, and otherwise arrange objects. Objects include shapes, t
and lines. You cannot perform all operations on all types of object
For example, you can only rotate or flip shapes.

Shape 
Numbering

Numbers shapes.

Zoom 
Control

Changes the view percentage.

Tool Command Description

Draw Draws shapes in a diagram.

Selector Selects, moves, and resizes drawn 
elements.

Rotate Rotates selected objects.

Reshape Edits the connect points in the graphic.

Rotate Right Rotates the selected objects 90 degrees
the right.

Rotate Left Rotates the selected objects 90 degrees
the left.

Flip 
Horizontal

Flips the selected objects horizontally.
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Flip Vertical Flips the selected objects vertically.

Arrange Opens a list of Arrange commands for 
modifying objects in the diagram. The 
Arrange commands are:

• Align - aligns shapes vertically and 
horizontally.

• Make Same Size - makes selected 
shapes same size.

• Even Spacing - spaces selected 
shapes evenly.

• Order - moves objects in your 
diagram. 

• Group - groups selected objects.
• Ungroup - ungroups selected grouped

object.
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Combine Opens a list of Combine commands so 
you can connect and disconnect closed 
and open objects. You can also form 
shapes from different combinations of 
operations. The Combine commands are

• Connect Open - connects the 
selected, closed objects.

• Connect Closed - connects the 
selected open objects and closes 
them.

• Disconnect - disconnects the selected
connected objects.

• Join - creates a new shape by joining 
the selected objects together.

• Intersect - creates a new shape from 
the intersection of the selected 
shapes.

• Outline - creates a new shape from 
the outline of the selected shapes.

• Slice - slices the selected closed 
shape with the selected open shape.
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Layer 
Manager

Opens the Layer Manager. In Layer 
Manager, you can change the visible, 
print, and lock properties of layers. Also, 
Layer Manager selects the current layer; 
adds, deletes, and renames layers; chang
the order of layers; and specifies whether
you want to change the current or all 
layers.

Fill Color Specifies the color for a shape.

Line Color Applies color to lines, line endings, and 
shape borders.

Text Color Applies color to text.

Line Style Changes the style (solid, dashed, dotted
for lines and shape borders. You can sele
from several line styles, such as solid and
dotted, which are also used to define the 
border styles for shapes.

Line Weight Determines line weight, or thickness. 
Click the tool and then use the arrows to 
adjust the weight. It is also used to set the
border weight for shapes.
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Arrowheads Sets the arrowhead styles for the selecte
line. When you click the tool, a list of the 
most commonly used arrowheads opens.
For a wider selection of arrowhead styles
click More at the bottom of the list.

You cannot change arrowhead styles on 
filled lines.

Crossovers Changes the crossover style for the 
currently selected line. To change the 
crossover style for the entire diagram, use
the Connector Line command on the 
Format menu.

Shadow Places a drop shadow on the current sha

3D Gives the shape a 3-dimensional 
appearance.
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Preset Styles Toolbar

The Preset Styles toolbar stores and accesses the styles that you
most frequently for text, shapes, and lines.

Tool Command Description

Shape 
Style box

Shows the current styles for 
shapes, including the border and 
shadow style and width, fill 
pattern, and color. The styles are 
applied to the next shape you place
in your diagram.

Add 
Shape 
Style tool

Adds the current shape style to the
Shape Style list.

Edit 
Shape 
Styles tool

Renames or removes the selected
item from the Shape Style list.

Line Style 
box

Shows the current styles for lines, 
including the line and arrow styles,
widths, and colors. The styles are 
applied to the next line you draw.

Add Line 
Style tool

Adds the current line style to the 
Line Style list.

Edit Line 
Styles tool

Renames or removes the selected
item from the Line Style list.
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iDiagram Toolbar

The iDiagram toolbar contains tools that help you set up and run 
iDiagrams.

Text Style 
box

Shows the current styles for text, 
including the font, size, style, and 
color. The styles are applied to the
next character you type.

Add Text 
Style tool

Adds the current text style to the 
Text Style box.

Edit Text 
Styles tool

Renames or removes the selected
item from the Text Style list.

Tool Command Description

Insert 
Entity

Inserts an entity into the selected shape.

Entity 
Manager

Shows or hides the Entity Manager.

Execute Runs the diagram.

Stop Stops the execution of an iDiagram.

Pause/
Resume

Pauses or resumes the execution of an iDiagram

Step Runs the diagram one step at a time.
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Use the Visual Basic toolbar to add or edit Visual Basic properties 
code to FlowCharter 2000 Professional shapes.

Tool Command Description

Visual 
Basic 
Editor

Displays the Visual Basic Editor.

Design/
Run Mode

Switches between the Design and the Run 
modes.

Properties Displays properties for the selected object.

Edit Code Edits the code for the object.

Code 
Assistant

Adds code to the object.

Controls Displays controls options.
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Model Toolbar

The Model toolbar contains all the tools needed for modeling 
functions. Most of the tools on this toolbar also appear as comma
in the Model menu. Use these tools with iGrafx Process 2000.

Tool Command Description

Start/Resume Starts or resumes the model simulation.

Pause Pauses the model simulation.

Stop Stops running the model simulation.

Trace Traces execution of the simulation.

Run Setup Modifies run setup data.

Generators Modifies generator attributes.

Resources Creates or modifies resources used for the 
simulation.

Schedules Creates or modifies schedules used for the 
simulation.

Events Creates or modifies events used for the 
simulation.

Attributes Creates, modifies, or initializes attributes used
for the simulation.

Functions Creates or modifies functions used for the 
simulation.
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1 On the ���� menu, click �����	
�.

2 Click ���.

3 Type a name for the new toolbar, and click 
�. 

4 Drag the tools you want from the ��������� dialog box to your 
new toolbar.

Tips
You can open the Tools menu and click Customize. With the 
Customize dialog box open, press CTRL, drag a tool from a toolbar 
and drop it into empty space to create a new toolbar.

Monitors Creates, modifies, or finds monitors used for 
the simulation.

Components Opens the Components dialog box for addin
and modifying components.

View 
Scenario

Displays the current scenario.

View Report Displays the report of the current scenario.
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1 On the ���� menu, click �����	
�.

2 Click the toolbar you want to rename.

3 Click ���	��.

4 Type a new name for the toolbar.

Note
You cannot rename an FlowCharter 2000 Professional toolbar. You 
can rename only the toolbars that you create.

To reset a toolbar

1 On the ���� menu, click �����	
�.

2 Click the toolbar you want to reset.
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3 Click �����.

Note
Resetting the toolbars returns them to the default, installed setting. 
This removes any tools that you added and adds tools that were 
originally on the toolbars.

Resetting the toolbars only affects those tools added or removed 
through the Customize feature in the Toolbars dialog box or Customiz
command on the Tools menu. 

Only the selected toolbar is reset.

To delete a toolbar

1 On the ���� menu, click �����	
�.

2 Click the toolbar you want to delete.

3 Click ������.

Note
You cannot delete an FlowCharter 2000 Professional toolbar. You ca
delete only the toolbars you create.
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1 Click in a blank area of the toolbar.

2 Hold down the mouse button and drag the toolbar from its 
position.

To dock a floating toolbar

1 Click in a blank area of the toolbar.

2 Drag the toolbar to any side of the program's window.

3 When the border changes from thick to thin, you can drop the 
toolbar into position.

To create a floating palette from a toolbar tool

1 Click one of the following tools. (These tools are on the �
	� 
toolbar).

2 Drag the palette off the tool.

Text Color Fill Color Line Color

Line Style Line Weight Arrowheads

Crossovers Shadow 3D
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3 If you want, you can close the �
	� toolbar. The floating palette 
remains open until you close it.

To show or hide toolbars

1 On the ���� menu, click �����	
�.

2 Select the toolbars you would like to view, or clear the toolbars
you no longer want to view.

3 Click 
�.

Using Color Palettes

With FlowCharter 2000 Professional, you can color text, lines, and
fills. You can change default color and create as many as 33 custo
colors.
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1 Click the ���������
 , ���������
 , or ���������
  

tool on the �
	� toolbar.

2 Click ��
������
�.

3 Click or drag anywhere in the large color window to select a 
color.

4 Click 
�. The color becomes the selected color for the fill, text
or line. It also appears in the color palette.

Tips
Move the vertical scroll bar on the right to adjust the amount of white 
and black in your color.

For finer control, you can type the values you want in the text boxes. 
Values must be between 0 and 255.

When the custom color palette is full, you can still add more colors. 
When you do, the first custom color (in the upper left corner) is 
removed and your new color is added in the lower right corner of the 
palette.

If you are using Windows-standard VGA (16 colors), certain colors 
appear different when drawing lines and typing text, because of the 
limitations of your display driver.
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To color an existing line

1 Click the line that you want to apply color to.

2 Click the ���������
  tool.

3 Click the color you want.

To color fill

1 Click the shape that you want to apply color to.

2 Click the ���������
  tool.

3 Click the color you want.

To color existing text

1 Click the text that you want to apply color to.

2 Click the ���������
  tool.

3 Click the color you want.

Using ToolTips

ToolTips are short messages that appear in bubble text. These 
messages help explain the name of the tool or button and, in som
cases, what the tool or button does.
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To show or hide ToolTips

1 On the ���� menu, click �����	
�.

2 Click �������������.

or

Clear the ������������� box.

To use ToolTips

1 On the ���� menu, click �����	
�.

2 Make sure the ������������� box is selected.

3 Point to a tool or button in the window, and hold the mouse stil
for a short time. A short message (bubble) appears, explaining
the tool or button.

Using Menus and Commands

For every task in FlowCharter 2000 Professional, there is a comm
Commands help you carry out actions for selected diagrams, mod
shapes, text and lines. You can also use commands to open dialo
boxes where more specific functions take place. In many instance
commands on menus have corresponding tools on toolbars.
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File menu

The File menu contains the following commands:

Command Description

New On the File menu, point to New and click one of the
three commands. You can create a new document 
a:

• Basic Diagram
• Process
• New document based on a template

Note
If you chose to install iGrafx Professional on your 
machine, then you can also create a new document 
as an Organization Chart.
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Open Opens an existing diagram or workspace.

You can open these file types:

• Documents (file names ending with an IGX, 
FLO, ABC, AF3, AF2, PFD, AFT, PFT).

• Templates (file names ending with the IGT 
extension).

• Workspaces (file names ending with the IGW 
extension).

The shortcut key is CTRL+O.

Close Closes the active document.

Close All Closes all documents.

Save Stores a document or template as a file.

The first time you save a new document choose 
where you want to store the file. Afterwards, each 
time you choose the Save command, your changes
are saved in that file. You also can save templates f
use with new documents.

Save As Makes a copy of the document under a new name
in another location, so that you have both the origin
document and a copy.
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Save 
Workspace

Saves the names of open documents and their 
window arrangement in a file.

When you open a workspace file, the document file
open and restore the arrangement.

Save as Web 
Page

Saves an FlowCharter 2000 Professional file with 
related HTML format or Java applets, including 
graphics, for publication on the Web. This feature 
also converts links to the diagram to HTML format.
When the diagrams are viewed on the Internet or a
intranet and if you converted the links, clicking on a
linked shape opens the associated diagram.

Components Manages diagrams and diagram components by 
listing them in a hierarchical, or outline, view. This 
makes it easy to add new diagrams, rename or edi
existing diagrams, and delete diagrams you are no
longer using.

Shape Library Adds shapes to the Toolbox toolbar. After you add
shape, you can change its size, line width, and colo
You can also duplicate or add Visual Basic 
functionality to a shape(s).

Template Provides information on the template associated w
the document.
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Page Setup • Sets the size of the page. 
• Sets the orientation of the page (portrait or 

landscape).
• Sets the scaling to fit diagrams on pages.
• Sets the size of the page margins (borders).
• Sets custom headers and footers.
• Sets the order in which pages are printed.
If you change your page margin, the objects on the
page also move. The default page size is determin
by the selected printer.

Print Preview Previews how the diagram looks when you print it

Print Prints your diagrams and adds them to presentatio
and reports.

You can print all the pages, a range of pages, or on
selected objects in the diagram.

You can also use the shortcut key: CTRL+P.

Send Creates an e-mail message with the current 
document as an attachment.

This feature works with any MAPI E-mail system. 
MAPI E-mail systems include Microsoft Mail, 
Microsoft Exchange, Microsoft Outlook, and Lotus 
cc:Mail.
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Recent File Lists the last four documents you opened or save
Quickly opens documents you recently changed. Th
complete path name appears for documents outsid
the current directory.

A number appears beside each document’s name.
You can type the number to open the documents o
click the document name.

Exit Closes open documents and the program. Use this
command when you finish working with the 
program, or when you want to free memory to work
in another program.
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Edit menu

The Edit menu contains the following commands:

Command Description

Undo Reverses the last action or change on a diagram. If a
action cannot be reversed, Can't Undo appears on th
menu.

Redo Reverses the last undo you made. A description of t
action to be redone follows the Redo command. For 
example, Redo Move indicates that Redo can redo a
move action.

If the program cannot reverse the most recent undo, 
Redo is not available.

Cut Removes the selected objects from a diagram and 
places them on the Clipboard.

Copy Copies the selected objects in a diagram and places
them on the Clipboard.

Paste Places the contents of the Clipboard into the active 
diagram.

Paste 
Special

Pastes information from the Clipboard in various 
formats.

Select Specifies the shapes, lines, text blocks, or OLE obje
that you want selected in a diagram.
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Select All Selects all objects in a diagram.

Clear Deletes the selected objects from a diagram.

The Clear command deletes objects permanently. Th
are not placed on the Clipboard. Use the Undo 
command to recover a cleared object.

Duplicate Duplicates the selected objects.

Find Searches for text in the diagram. You can search the
diagram (including shapes, lines, and master Items),
notes, in data fields, or in all of these elements. You c
look for the text as a whole word and search for the te
exactly as you have entered its case.

Replace Searches for and replaces text in shapes, lines, not
and the entire diagram.

You cannot replace shape numbers.

OLE Links Opens a list of the objects linked to the active diagra

Use this command to update the object with changes
made in the source file, open the source file, change t
source file or item, or break the link to the source file

You can only change the links of linked objects. For 
example, you cannot break a link of an inserted obje

 Object Opens the object application so you can change the
linked or embedded object.
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View menu

The View menu contains the following commands:

Properties Displays the Properties dialog box for setting or 
modifying properties of selected objects.

Command Description

Normal Displays the diagram graphically.

Tabular Displays the diagram as a table with associated data
each shape.

Full Screen Displays all of the elements of your diagram on the 
screen without menus or tools. Press ESC to return t
the previous view.

Master Page Displays the items that appear on every page. For 
example, if you place a shape in the bottom left-hand
corner of the master page, this shape appears in the
same place on every page.

Toolbars Displays or hides toolbars. You can also customize 
toolbars, reset toolbars, create new toolbars, delete 
custom toolbars, choose large or small tool sizes, 
choose color or black and white tools, and show or hid
ToolTips using this command.

Status Bar Displays or hides the status bar.

Output Displays or hides the output window.
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Gallery Displays or hides the gallery.

Note Displays or hides the Note window.

Hidden 
Lines

Displays or hides hidden lines.

Page Breaks Displays or hides page breaks.

Rulers Displays or hides the rulers.

Zoom Changes the magnification of a diagram. To zoom in
means to magnify. To zoom out means to reduce the
magnification.
� � � � � � � � 	 
 � � 
 � � � � � � � � � � � � � 
 � � � � � 
 � � 	  34



Home Index Previous Page Next Page
iGrafx
S Y S T E M

r 

nts.
Insert menu

The Insert menu contains the following commands:

Command Description

Link Inserts a link from a shape to another diagram, file, o
URL.

Department Inserts a new department.

Phase Inserts phase lines in diagrams containing departme

Picture Inserts a picture from a file.

iGrid Inserts an iGrid.

SPC Chart Inserts SPC charts.

OLE Object Inserts objects from other applications.
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Format menu

The Format menu contains the following commands:

Command Description

Font Sets the font, size, color, and orientation for diagram
text. 

Text 
Alignment

Selects between horizontal or vertical alignment, and
sets text orientation and tab size.

Text Layout Sets text and subtext area sizes for shapes.

Fields Creates or edits shape fields.

Numbering Displays or hides shape numbers, automatically or 
manually renumbers shapes, and sets the next shap
number. 

Fill Sets shape fill styles as solid, pattern, or gradient.

Line and 
Border

Sets line size, style, and color.

Shadow/3D Chooses shadow or 3D styles for shapes.

Callout 
Line

Chooses callout line sizes, styles, and colors.

Diagram Edits the properties for departments.
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Tools Menu

The Tools menu contains the following commands:

Command Description

Spelling Checks the spelling of any text included in documen
You can check the spelling of all the text in the 
document, or only selected text.

Protect 
Diagram

Sets or removes password protection to protect your
diagram from unauthorized changes.

Change 
Diagram 
Type

Changes a Basic Diagram to a Process Diagram or a
Organization Chart.

Note
You cannot change a Process Diagram to a Basic 
Diagram, or change an Organization Chart to either a 
Basic Diagram or a Process Diagram.

iDiagram Runs an iDiagram, assigns a starting entity to a sha
and opens the Entity Manager.

Visual Basic Uses the Visual Basic Editor to edit codes, views VB
shape properties, and assign VB macros to shapes.

Custom 
Data

Manipulates custom data, inserts legends, creates, 
displays, and updates custom data.
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Arrange menu

The Arrange menu contains the following commands:

Export 
Diagram

Exports a diagram to another file. 

Export 
Table

Saves diagram attributes as a tab delimited *.txt file fo
exporting into a database management tool such as 
Excel.

Customize Customizes the program toolbars and the Toolbox.

Options Sets options for shape spacing and alignment, line 
spacing, spell checking, displaying the Finished butto
displaying the Welcome dialog, and setting the numb
of Undos and Redos.

Command Description

Align Aligns shapes vertically and horizontally.

Make Same 
Size

Makes selected shapes the same size.

Space 
Evenly

Spaces selected shapes evenly.

Auto 
Layout

Opens the Auto Layout dialog box where you choose
options for cleaning up the layout of your diagram.
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Grid Snaps a selected object to the grid, displays or hides
grid dots, or snaps all objects to the grid.

Guidelines Displays or hides vertical or horizontal guidelines or
snaps selected objects to the guidelines.

Connect 
Shapes

Uses a connector line to connect selected shapes.

Replace 
Shape

Replaces the selected shape(s) with the shape in the
Shape Library, Shared Media, or the Clipboard.

Reverse 
Ends

Reverses the ends of the selected line. This changes
direction of the flow for that line.

Fit to Text Resizes the selected object or objects based on the
text.

Rotate/Flip Rotates or flips the selected object.

Order Moves objects in your diagram. You can send object
to the back, bring objects to the front, send an object
one level backward, or bring an object one level 
forward.

Layers Provides a submenu of commands that opens the La
Manager, edits all layers, adds layers, selects a layer
move to, moves the layer back one layer, and moves 
layer forward one layer.

Convert To Converts a shape to a graphic or a graphic to a shap
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Model menu

The Model menu contains the following commands. Use these 
commands with iGrafx Process 2000.

Combine Groups and ungroups objects and connects and 
disconnects closed and open objects. Also, forms ne
shapes from different combinations of operations tha
you can perform with shapes.

Command Description

Run Runs a check, or test, on the simulation. You can als
start, stop, or trace a simulation.

Run Setup Modifies run setup data.

Generators Modifies generator attributes.

Resources Creates or modifies resources used for the simulati

Schedules Creates or modifies schedules used for the simulati

Events Creates or modifies events used for the simulation.

Attributes Creates, modifies, or initializes attributes used for th
simulation.

Functions Creates or modifies functions used for the simulatio

Monitors Creates, modifies, or finds monitors used for the 
simulation.
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Window menu

The Window menu contains the following commands:

Types Defines the types associated with the simulation.

Transaction 
Groups

Defines the transaction groups associated with the 
simulation.

Find Start Finds the start point for your simulation.

Command Description

New Window Creates a new window for the active diagram.

Tile Vertically Tiles windows vertically.

Tile 
Horizontally

Tiles windows horizontally.

Cascade Cascades windows for minimizing or maximizing.

Split Divides the active window into four panes. You can
then view more than one window at the same time.

Window List Displays the names of the windows open currently
The numbers indicate the order in which the 
windows were opened. A check mark indicates 
which window is active.
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Help menu

The Help menu contains the following commands:

Command Description

iGrafx Help Displays the help file for finding specific 
information about using the program.

Learn About Help Describes the advantages of using help.

Tip of the Day Displays program tips.

Using Help Describes how to use the help file.

iGrafx Home Page Displays the home page for the FlowCharte
2000 Professional product in the Micrografx 
Internet site.

Micrografx Home 
Page

Displays the Micrografx Internet home page.

Office Compatible Describes how FlowCharter 2000 Profession
is compatible to Microsoft Office.

About iGrafx Displays the program’s version number, 
copyright, and licensing information.
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Getting Started with Diagrams

Creating New Documents

This manual refers to both documents and diagrams. These conc
are different because:

Documents are containers—They can be a single component such
Basic Diagram or a Process, or contain more than one Basic Diag
or Process. When you create a document, it includes one diagram
default. You create, open, save, and distribute documents.

Diagrams are components of the document—In diagrams, you ca
place shapes and draw graphics. You can also view, edit, print, an
link diagrams to other diagrams in a document. Collecting and link
multiple diagrams to one document keeps corresponding informat
in one place.

FlowCharter 2000 Professional offers two ways to create docume
You can create documents using:

• ��� ��� dialog
• ���� ���	�! on the �����menu
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Welcome dialog

The ��� ��� dialog is the first entry point into FlowCharter 2000 
Professional. This dialog offers a graphical point of reference for 
creating new documents and opening existing ones.

Note
You can bypass the Welcome dialog by clicking the Don’t Show This 
Startup Screen Again box in the lower left-hand corner of this dialog.

If you decide later that you want to see the Welcome dialog, use the 
Options command on the Tools menu to make this change.

New command

The ��� command creates a new document with or without using
template. You can use the ��� command on the ���� menu during any 
part of your session, including startup.

FlowCharter 2000 Professional includes a manager for templates
Clicking �����	�� on the ���� menu opens the �����	�� dialog 
box. Use this box to apply templates, check the dates of template
updates, and synchronize an opened document with the most up-
date template.
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To create a new document from the Welcome dialog

1 On the Windows���	
� menu, point to �"
	#�, and click 
������	
��
�$%%% &
�#������	�.

2 In the ��� ��� Dialog, click ������ �����, and then click 


'	���	���� ��	
�, &
� ���, or�(	�� ���	'
	�.

To create a new document using the New command

1 On the Windows���	
��menu, point to �"
	#�, and click 
������	
��
�$%%% &
�#������	�.

2 On the �����menu, click ���. You can select:



'	���	���� ��	
� to open iGrafx OrgCharter.

&
� ��� to open a process diagram with a default department 
lane.

(	�� ���	'
	� to open a new, blank diagram window. 

�
��������	�� to open the New dialog box to select a templat
file.

To create a document from a template

1 On the ���� menu, point to ���, and click �
��������	��.

2 Click the template you want.

3 Click 
�.

4 On the ���� menu, click �	)��*�.
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5 In the �	)��	���+�� box, select �"
	#�,-.�'�/.

6 Save the document under a new name.

To create a new template

1 On the ���� menu, point to ���, and click (	�� ���	'
	�.

2 Make changes to the document settings and styles.

3 On the ���� menu, click �	)��*�.

4 In the �	)��	���+�� box, select �"
	#�������	���,-�'�/.

5 Give a name to the template in the ���� name box.

6 In the �	)���� box, click the drive where you want to save the 
template.

7 Select the folder where you want to save the template.

8 Click �	)�.

Note
You cannot use templates created in FlowCharter 2000 Professional i
FlowCharter 7. Instead you must save them as FLO files and convert
them to templates within FlowCharter 7.
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Opening Documents

FlowCharter 2000 Professional offers two ways to open documen

• ��� ��� dialog- Use the ��� ��� dialog to open documents 
that you have already created.

• ���� menu- Use the 
��� command on the ���� menu.

To open a document using the Welcome dialog

1 On the ���!������	
��menu, point to �"
	#�, and click 
&
�#������	�.

2 In the ��� ��� dialog, click 
��������, and then browse to the 
folder containing your document.

To open a document using the Open command

1 On the ���� menu, click 
���.

2 In the ���0��� box, choose the drive where the document resid

3 Double-click on the folders to open the folder where your 
document resides.

4 If necessary, choose the type of file you want to open in the ������

�#��+�� box.
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5 Click the document you want to open.

Tip
You can also use the shortcut key: CTRL+O or the Open  tool on 
the Standard toolbar.

Importing Other Formats

You can take a FlowCharter chart, an Optima file, or an Optima 
Express file, and convert the data into an FlowCharter 2000 
Professional document.

Shapes and lines are automatically converted along with text and 
graphical information. All linked FlowCharter subcharts can be 
imported optionally so that the design maintains the hierarchy of 
processes.

FlowCharter Charts

When importing FlowCharter charts, you may notice a few things:

• Horizontal swimlanes are converted automatically to 
FlowCharter 2000 Professional departments, and their shapes
converted into activities within the appropriate departments. 

• If FlowCharter 2000 Professional finds links to other 
FlowCharter charts in the file, you receive an Import Options 
message.
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If you choose Yes, the shapes are converted to Process activities 
the contents of the linked files are converted into subprocesses. If
choose No, the documents remain separate.

The following table helps you understand the conversion of Proce
elements:

Element Description

Shapes During conversion, any shape that is connected by 
line to another shape is automatically converted to an
activity. 

Graphics 
and lines

Any shape that is not connected to another shape is 
converted to a graphic. Also, any line that does not 
connect shapes is converted to a graphic. Any line th
connects shapes is automatically converted to a 
connection line. 

Decisions 
and Splits

A shape that has more than one labeled output is 
converted to a Decision activity. A shape that has mo
than one unlabeled output, and is not a diamond sha
is converted to an implicit Split activity. 

Text Any text object, other than text that labels an output 
line from a symbol, is converted to a text graphic.

OLE Any OLE object is converted to an OLE graphic.
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To open a FLO file

1 On the ���� menu, click 
���.

2 In the ���0����box, choose the drive where the file resides.

3 In the box, double-click the folders until you open the folder 
where your file resides.

4 In the �������#��+�� box, click �� 
�'
	#��������	
��
�1.%�

�����,��
/.

5 Click the FLO file you want to open.

To open a PFD file

1 On the ���� menu, click 
���.

2 In the ���0����box, choose the drive where the file resides.

3 Double-click the folders to open the folder where your file 
resides.

4 In the �������#��+�� box, click �� 
�'
	#��
����	�$.2������

,&��/.

5 Click the PFD file you want to open.

To open a DRW file

1 On the ���� menu, click 
���.

2 In the ���0��� box, choose the drive where the file resides.
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3 Double-click on the folders to open the folder where your file 
resides.

4 In the �������#��+�� box, click �� 
�'
	#���
	��3.%������

,���/.

5 Click the DRW file you want to open.

Exporting Diagrams and Tables

You can use FlowCharter 2000 Professional to export diagrams a
tables to other image editing and database management applicati
Both options are useful, but produce different results.

Image Editing–Choose the 4���
����	'
	� command to preserve 
how the diagram looks on the page. You can save elements such 
shapes, lines, and text along with their formatting and position as 
types that you can view in other image editing applications.

Database Management–Choose the 4���
���	��� command to 
preserve the information contained within the shapes as tab-delim
data. You can save field information such as links, IDs, coordinate
and shape numbers in a table format for exporting or copying into
database and speediest applications.

To export a diagram

1 On the ����� menu, click 4���
����	'
	�.

2 In the 4���
����	'
	� dialog box, type a name for the diagram
in the ������	�� box.
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3 Choose the drive and directory in which you want to store the 
diagram.

4 Select what you would like to save the diagram as in the �	)��	��

�+�� box.

5 Click �	)�.

Note
Depending on what type you want to save your diagram as, 
another dialog box may appear where you can select additional 
options before saving.

To export a table

1 On the ������menu, click 4���
���	���.

2 In the 4���
���	����dialog box, expand the field lists in the box.
To view the fields in alphabetical order, select the *���	���� 	� 
option.

3 Drag the fields contained in your diagram from the list down to
the window at the bottom of the dialog box, and drop them.

Note
If you are in the tabular view when you open the Export Table dialog 
box, the set of columns are not identical to, but contain the same data
as, the visible tabular view columns.
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4 To save your field selections as a predefined set, click �	)��*�, 
and type a name for them in the�&
�!�#���!����� select box.

The set is saved and appears in the &
�!�#���!����� select list. 
The set will also appear as a selection the next time you open 
4���
���	��� dialog box.

Tip
You can also select the Include Headers box to label columns 
appearing in your table. Selecting this option labels the first row of 
each column the same as header rows. To edit the header labels, clic
on the first row in each column and type a new name.

5 Click 4���
�.

or

Click ���+.

Export–Opens the �	)��*� dialog box where you can save your
dropped fields as a tab-delimited text file. When you open an 
application like Excel, it recognizes that you have saved a tab-
delimited file and organizes your fields accordingly.

Copy–Copies your fields to the clipboard for pasting into anoth
application that recognizes tab-delimited information.

Tip
Click Copy in the Export Table dialog box and then click the Paste 
command on the Edit menu in Excel for the quickest export.
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To change the field view for exporting a table

1 On the ����� menu, click 4���
� �	���.

2 In the 4���
���	��� dialog box, select either *���	���� 	� or 
(+ "
���.

To modify and save predefined sets for exporting or copying a 
table

1 On the ����� menu, click 4���
���	���.

2 In the 4���
���	��� dialog box, select an existing predefined se
from the &
�!�#���!���� select box, drag an existing field(s) 
from the window at the bottom of the dialog box back up to the
field list, and drop.

3 Click �	)��*�.

4 Rename the predefined set.

To reorder columns before exporting or copying a table

1 On the ����� menu, click 4���
���	���.

2 In the 4���
���	��� dialog box, select a predefined set from the
&
�!�#���!���� list box.

3 In the window at the bottom of the dialog box, click a column, 
and drag it left or right. Repeat this procedure to reorder other
columns appearing in your table.

4 Click 4���
�.
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or

Click ���+.

To remove columns before exporting or copying a table

1 On the ����� menu, click 4���
���	���.

2 In the 4���
���	��� dialog box, select an existing predefined se
from the &
�!�#���!�����select box, drag an existing field out 
from the window at the bottom of the dialog box and drop them
in the list box above the window.

3 Repeat this procedure to remove other columns from the table

4 Click 4���
�.

or

Click ���+.

Viewing Diagrams

FlowCharter 2000 Professional offers several ways to view new 
diagrams you are creating, or view documents you have already 
created. Before using a view, ask yourself the following questions

• What type of diagram do I want to create?
• How will I be using a diagram already created?
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Normal View

Normal is the most popular view for editing diagrams. In Normal vie
you work with a diagram space, or the area containing shapes, 
graphics, text, and lines. This space is set by default at 100%. Us
5��������
�� to change the view percentage to view more or less
the diagram space.

Tabular View

The Tabular view can be used for viewing data contained within th
diagram. This includes departments, shapes, and connector lines

Note
You can edit data in both the Normal and Tabular view.

Full Screen View

Use the Full Screen view to show someone the diagram and do a c
talk about it. While in full-screen mode, draw on the screen. When
you finish, press ESC to return to the previous view. In the Full Scr
view, use the mouse buttons to draw using different colors.

• To draw in red, click the left mouse button and drag.
• To draw in green, click the right mouse button and drag.
• To draw in yellow, click both mouse buttons and drag.
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• You can use the following keys when working in Full Screen 
view: �4�, ��	 ��	
, 4 - Erase diagram annotations, �*(, 
&*"4��
��, � - Go to the next diagram window, and 
�67��8�*(, &*"4�9&, & - Go to the previous diagram window.

Master Page View

Master Page view shows you what elements appear on the Maste
Page. Anything placed on the Master Page appears on every pag
the diagram when printing or using the &
��� &
�)��� command.

To use Normal view

On the ���� menu, click ��
�	�.

To use Tabular view

On the ���� menu, click �	���	
.

To use Full Screen view

1 On the ���� menu, click ������ 
���.

2 To draw in red, click the left mouse button and drag.

or

To draw in green, click the right mouse button and drag.

or

To draw in yellow, click both mouse buttons and drag.
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3 Press 4�� to leave the full-screen view.

To view the Master Page

On the ���� menu, click��	���
�&	'�.

Zooming Diagrams

Changing the zoom percentage on a diagram helps you get a bet
view of a shape or a group of shapes. Zoom in to see text and not
a few shapes, or zoom out to see the layout of all shapes.

To choose a zoom percentage

1 Click the object you want centered in the window.

2 Click the down arrow in the 5���  box on the ��	�!	
! 

toolbar.

3 Click the viewing percentage at which you want to view the 
diagram.

4 To scale the diagram to fit in the current window, use (�������.

or

To always view the entire diagram, use ����.

Tips
You can also use the Zoom command on the View menu to change th
zoom percentage.
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Using FlowCharter 2000 Professional Tools

Several tools and commands exist in FlowCharter 2000 Professio
to help you change the appearance of diagram components, give
information about performing tasks, and split up the visible diagra
space.

These tools include:

• Gallery
• Share Media
• Notes
• Output Window
• Status Bar
• Rulers, Page Breaks, and Hidden Lines
• Window commands

Gallery 

The Gallery is a formatting command center. From the Gallery, yo
can drag and drop shapes, change color, add text and lines, add 
shadows and 3D attributes, and change fonts and line ends. The 
Gallery is positioned on the right-hand side of the screen for easy
access.
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iGrafx Share Media

After you install iGrafx Share Media it becomes part of the Gallery
contains many features that makes communicating with graphics 
and efficient.

With iGrafx Share Media, you can:

• Browse and access media quickly with the Media Browser.
• Customize toolbars and ToolTips.
• Bring in multimedia files, such as AVI, WAV, and Animated GIF

files.
• Play multimedia files in place when you pause the cursor over t

thumbnail of the file.
• Bring in graphics from a digital camera or scanner.
• Easily customize the look and feel of iGrafx Share Media with 

the Customize Workspace Wizard.
• E-mail media to coworkers with the Send Wizard.
• Access frequently used media with the Bookmark feature.
• Create portable collections quickly and easily with the Packag

Media Wizard. This lets you work with graphics when you're 
away from the office.

• Find and import media by file type with the Import Files Wizard
• Print one or more graphics with the Print Wizard
• Keep Share Media on top of other applications for ease in add

graphics to your documents
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• Add media using Windows Explorer, even if Share Media is no
open.

Note
The features you see in Share Media depend upon the way your syste
administrator sets up Share Media on your computer.

Notes

The Note window contains text attached to a certain shape. You c
hide notes containing detailed information about a step or process
you do not want displayed in a diagram. Note text can also be cop
from one shape and pasted into another.

Type and change notes inside the Note window. The Note window
displays the shape number of the selected shape (if any), and the
attached to the shape. In a diagram, shapes with notes attached a
marked by default with the letter N.

Tip
In the Format Diagram dialog box, click the Indicators tab to change 
the indicator for notes. You can also display the actual text in the 
diagram using the Fields command on the Format menu.
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Indicators

Indicators are shadows and symbols added to shapes, and nodes
to lines. Shape indicators help you identify shapes that are used t
open linked diagrams (or launch other applications) or that have n
attached to them.

• Shapes that open linked diagrams (or launch other application
can be indicated with text, a shadow, an icon, or a line.

• Shapes that have notes attached to them can be indicated wit
text or a shadow.

You can use shadows and choose the symbols used for indicators
default indicators are a shadow for link and -N for notes. You can 
up to three text characters to create your own indicators. Also, use
���� option and click ��
�	��to open the ���0 7�!� 	��
 ��
�	� 
dialog box to format the way lines appear as an indicator for linke
diagrams.

Tip
You can choose the font, point size, color, and style you want for text
indicators. The settings you choose are also used for shape numbers
� � � � � � � � � � � � � � � � � � � 
 � � � � � � � � �  62



Previous Page Next Page
iGrafx
S Y S T E M Home Index

ings. 
ors 
g 
ou 

. 

 

blem 

ms 
Output Window 

The Output window is used to display messages, errors, and warn
For example, if you add expression information to a shape any err
in this expression will display in the Output window. Double-clickin
on the error in the Output window takes you to the shape where y
can repair the error.

Status Bar

Use the Status Bar for help on toolbar tools and menu commands
Passing the cursor over items in the window displays a short 
description about the item.

Rulers, Page Breaks, and Hidden Lines

Rulers, page breaks, and hidden lines serve as navigators for the
diagram space. Without them, it is difficult to align shapes and 
determine logical points that break up the page. This can be a pro
in large diagrams where you must use the�5��������
���to view 
everything.

Window commands

Window commands help you manage your workspace and diagra
that you create or have open. You find these commands on the 
���!�� menu.
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On the ���� menu, click "	���
+.

To open iGrafx Share Media

On the����!������	
� menu, point to �"
	#�, and click���	
��
��!�	.

To open the Note window

On the ���� menu, click�����.

Tip
You can press F6 to open and close the Note window.

To attach a note to a shape

1 If the Note window is not displayed, click Note on the ���� 
menu.

2 Select the shape to which you want to attach a note.

3 Click in the Note window, and type the information you want.

4 Close the Note window.
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To delete text in the Note window

1 If the Note window is not displayed, click Note on the ���� 
menu.

2 Select the shape to which the note is attached.

3 Point inside the Note window. The pointer changes to the I-bea
pointer.

4 Select the text you want to delete.

5 On the ���� menu, click ���	
 or press the �4�4�4 key.

To print a note

1 On the ���� menu, click�����.

2 Select the shape to which the note is attached.

3 On the ���� menu, click &
���.

4 Choose the print options you want.

5 Click 
�.

To choose indicators for shapes

1 On the ��
�	� menu, click ��	'
	�.

2 In the���
�	����	'
	� dialog box, click the 7�!� 	��
� tab.

3 To set the indicator type for a shape with a link, click the down
arrow in the ���0 area, and click the type you want to use.
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4 If you want to use a text symbol to indicate a shape with a link
type up to three characters in the box in the ���� area.

5 If you want to use a shadow to indicate a shape with a note, se
the ��	!�� option.

6 If you want to change the indicator style for nodes or 
intersections, choose a new style and color.

7 Click 
�.

To open the Output window

On the ���� menu, click 
�����.

To use the Status Bar

Move the cursor over any toolbar tool or menu command.

A description of the tool or command appears in the lower left-han
corner of the FlowCharter 2000 Professional window.

To turn rulers on or off

On the ���� menu, click ����
�.

To turn page breaks on or off

On the����� menu, click &	'��(
�	0�.

To turn hidden lines on or off

On the ���� menu, click 6�!!��������.
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To tile windows vertically or horizontally

On the ���!�� menu, click �������
�� 	��+ or �����6�
�����	��+.

To cascade windows

On the ���!�� menu, click �	� 	!�.

To split windows

On the ���!�� menu, click �����.

Editing Diagrams

You can find most of the editing functions in FlowCharter 2000 
Professional on the 4!�� menu. On this menu you can do things like
duplicate objects and find text. Editing is different from formatting 
that you are working with existing components, and not changing 
size, or applying new colors, lines, and text.

Through editing, you can do things like:

• Change an open diagram and save it under a new name. This
saves you from creating a new one.

• Paste special text and graphics from other applications into 
FlowCharter 2000 Professional.

• Find text occurrences in diagram shapes or notes, and replace
them with a different word or phrase.
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Cutting, Copying, and Pasting

With FlowCharter 2000 Professional, you can cut, copy, and paste
objects or groups of objects to the Clipboard for moving into anoth
diagram or even another application.

The &	������� �	� command pastes information from the Clipboar
into your diagram in various formats. Use this command to link 
information to the active diagram.

Depending upon the information in the Clipboard, your paste form
options may include an embedded OLE object, Rich Text Format 
(RTF), non-formatted text, a metafile (which acts as a diagram sha
and a bitmap.

After you link an object to a diagram, any changes made to the ob
in its source file in the original program (the object application) are
reflected in the diagram.

Note
The difference between the Paste Special command’s Paste Link 
option and the Insert Object command is that when you insert an 
object, the entire object is included in your diagram. With the Paste 
Link option, you can select a portion of a document, spreadsheet, or 
bitmap and paste it into your diagram. When something is Paste 
Linked, you cannot change it in your diagram as you can an inserted 
object.
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Selecting, Deleting, and Duplicating Diagram Objects

Use the ���� � and the ���� ��*�l commands on the 4!�� menu for 
deleting or duplicating diagram objects. On the ���� � dialog box, 
you can choose which diagram components to select or ignore.

Finding and Replacing Text

Use the ���! command to search text in diagrams, custom data fie
or notes. You can search for exact words or variations of a word. F
example, select the �	� �  	�� option on the ���! dialog box, type 
the word auto, and the search finds auto and automobile.

Spell Checking

The spell checking feature checks spelling by comparing words in
your document with words in a dictionary. The default dictionary is
file containing thousands of words. If a word is found that is not in 
dictionary, the word is considered a possible misspelling.

The program displays a list of words similar to the misspelled wor
You can select one of the words, type the correct spelling yourself
ignore the word, or add the misspelled word to the user dictionary

You can customize the spell checker by:

• Defining user dictionaries for special purposes.
• Specifying that the program ignore words with numbers during

spell checking.
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Protecting Diagrams

At times, you might want to prevent other people from modifying a
diagram. You can protect a diagram by assigning it a password. N
one is able to type field data into it until the password is typed 
correctly. If the diagram contains hidden data fields, they are hidd
from view until the password is entered correctly.

You can use password protection to manage linked files. By assig
each person in a workgroup a different password, you can ensure
each person has access only to his or her own diagrams.

To undo an action

On the 4!�� menu, click 9�!�.

or

Click the 9�!�  tool.

To redo (reverse) your last undo

On the 4!�� menu, click ��!�.

or

Click the ��!�  tool.
� � � � � � � � � � � � � � � � � � � 
 � � � � � � � � �  70



Previous Page Next Page
iGrafx
S Y S T E M Home Index
To cut objects

1 Select the object or objects to cut.

2 On the 4!�� menu, click ���.

or

Click the����  tool.

Tips
The keyboard shortcut for cutting an object is CTRL+X.

Shapes or text cut or copied from the diagram window cannot be 
pasted into the Note window.

To copy objects

1 Select the object or objects you want to copy.

2 On the 4!�� menu, click ���+.

or

Click the ���+  tool.

Tips
You can also press CTRL+C to copy a selected object.

Shapes or text copied or cut from the diagram window cannot be 
pasted into the Note window.
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To paste objects

On the 4!�� menu, click &	���.

or

Click the &	���  tool.

Tips
You can also press CTRL+V to paste the object.

You can paste notes into the active diagram window using the Paste 
command. Before you can paste something from the Note window, 
you must select a shape or click the left mouse button on the active 
diagram.

To use the Paste Special command

1 Select the object(s) or text in another application.

2 Copy the objects to the application’s clipboard.

3 Switch to �"
	#� ������	
��
�$%%%�&
�#������	�.

4 On the 4!�� menu, click &	��� ��� �	�.

5 Select the paste type (as text, picture) from the list.
� � � � � � � � � � � � � � � � � � � 
 � � � � � � � � �  72



Previous Page Next Page
iGrafx
S Y S T E M Home Index

 

at 
6 Click 
�.

Note
If you have copied a linked object or text from another application, the
Paste Link option is selected on the Paste Special dialog box. This 
keeps this object or text linked back to its original application.

To select diagram components

1 On the 4!�� menu, click ���� �.

2 Click one or more of the check boxes to select all objects of th
type.

Tips
In the Name box, you can click a shape name to select all shapes of 
that kind.

You can also select all objects using the Select All command on the 
Edit menu.

You can select multiple objects. Press and hold SHIFT as you click 
each object.
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To delete objects

1 Select the object you want to delete.

2 On the 4!�� menu, click ���	
.

Tips
You can also press DELETE to delete the selected object.

When you choose the Clear command, objects are deleted 
permanently. They are not placed on the Clipboard.

Use the Undo command to recover a cleared object.

To duplicate objects

1 Select the object or objects you want to duplicate.

2 On the 4!�� menu, click ����� 	��.

Note
You can also press and hold the CTRL key and drag the selected 
objects to duplicate them.
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To find text

1 On the 4!�� menu, click ���!.

2 Enter the text to find.

Note
The search finds text only in the diagram. It cannot search inserted 
OLE objects from other programs. To find text in inserted objects, 
open the object and search for the text within its program.

You can search the diagram (including shapes, lines, and master 
items), in notes, in data fields, or in all of these elements.

To replace text in a diagram

1 In the 4!�� menu, click ����	 �.

2 Type the text you want to find in the ���! box.

3 Type the text you want to use as replacement text in the ����	 � 
box.

To choose spelling options

1 On the ����� menu, click 
������.

2 Click the �������' tab.

3 Type the path and file name of the dictionary to be used for sp
checking.
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4 To ignore words with numbers, click 7'��
� ��
!�������

�����
�.

5 Click 
�.

To check spelling

1 Select the elements you want to spell check. If no elements ar
selected, the entire diagram is spell checked.

2 On the ����� menu, click �������'.

or

Click the �������'  tool.

Note
Misspelled words are displayed in the Not in Dictionary box. A 
suggested replacement is shown in the Change To box.

3 You can type in a replacement or choose another replacemen
from the list.

4 To correct the word, click ��	�'� or ��	�'� *��.

5 If the word is not misspelled, click *!! to add the word to the 
user dictionary and continue, or click 7'��
� or 7'��
��*�� to 
ignore the word or every instance of the word.
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To protect a document

1 On the ����� menu, click�&
��� ���� �����.

2 In the &	����
! field, type a password.

3 In the ��
�#+ field, type the same password again.

4 Click 
�.

Note
If you open a protected diagram a message reminds you that you hav
to type the password before you can make changes to the diagram.

To unprotect a document

1 On the ����� menu, click 9��
��� ���� �����.

2 Type the correct password.

3 Click 
�.

Note
If you enter the wrong password, a message appears telling you that 
the password is incorrect. Click OK and enter the correct password. I
you do not know the password, click Cancel. You can change the 
diagram after you enter the correct password.
� � � � � � � � � � � � � � � � � � � 
 � � � � � � � � �  77



Previous Page Next Page
iGrafx
S Y S T E M Home Index

s 
e 
lso 
in a 

ns:

k 

n 
Printing Diagrams

When you print a diagram, you can choose several options such a
including or excluding diagram components, queuing just the activ
diagram or the entire document set, or printing to a file. You can a
choose the option to print all of the diagrams and components with
document.

Check the following commands and dialog boxes for printing optio

• The &
��� command on the ���� menu. This opens the &
��� 
dialog box where you can select or change options.

• The &	'������� command on the ���� menu. This opens the 
&	'������� dialog box where you can select the 
������ tab to 
find other print options. These print options include:

Frame—Prints frames around diagram pages if you are in Boo
Mode.

Notes—Prints notes on shapes.

To print a diagram

1 On the ���� menu, click &
���. Information about the printer 
appears at the top of the dialog box. (The printer information 
applies to the printer to which the next print job is sent.) You ca
also choose another printer.

2 Choose a &
�����	�'� option.

3 In the ������ text box, type the number of copies you want.
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4 In the &
������	� box, select the active diagram or the entire 
document.

5 To send the output to a file instead of a printer, select the &
�������

���� box if you want.

6 Click�
�.

Tips
You can also use the shortcut key: CTRL+P.

If you choose the Print to File option, a dialog box opens. Type the file
name you want and click OK. The diagram information is saved in a 
file in the current directory.

To print Notes or blank pages, choose the print order, and fit the 
diagram to the page, click Page Setup on the File menu, then click th
Print Options tab.

To see a print preview of your diagram

On the����� menu, click &
����&
�)���.

Tip
You can zoom in by clicking the diagram area you want to see in more
detail.
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Saving and Closing Documents

You can save a document by naming it or renaming it, and clicking
following commands on the ���� menu:

• �	)� and �	)��*� - Save a document as an FlowCharter 2000
Professional document or template, older FLO files, or a DRW
file.

• �	)����
0��	 � - Saves your document as an iGrafx 
Workspace (*.igw)

• �	)��	������&	'� - Saves your document(s) for publishing on
the Web.

If you plan on distributing documents to others, save them as Web
pages or as older FLO files. Before sharing these documents with
others, ask if they have a Web browser or an older version of 
FlowCharter installed.

You can close a document or documents using the �����, ������*��, 
or 4����commands on the����� menu.

Saving Documents in Older FLO Formats

Saving your documents in the FLO format enables those individua
who use FlowCharter 7 to open and view documents.
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Saving a Workspace

A workspace is the set of currently open documents. Because you
often work on the same set of documents for a project, the worksp
feature opens them to resume your work. When saving a workspa
you can save the names of the open documents (not the docume
themselves) and the arrangement of the documents in the progra
window.

Saving as a Web Page

After you create a document in FlowCharter 2000 Professional, yo
can output it to Hypertext Markup Language (HTML), Java® Applets, 
or WebCGM file. HTML is a standard language that defines the 
layout, text, and graphics of a Web page.

When you save a file to HTML or Java, you specify which parts of 
diagram are to be saved as part of the Web page. You can view th
HTML output with a Web browser such as Netscape Navigator or 
Microsoft’s Internet Explorer, or any other Web browser that suppo
images, client-side image maps, and tables.

Element Description

Images The Web browser should be able to view GIF files.

Client-side 
image maps

The Web browser should support client-side image 
maps so that the navigation from the diagram images
works.
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At the bottom of each Web page is an index of any other diagram l
that were included.

WebCGM Files

WebCGM is a subset of the ISO Computer Graphics Metafile (CG
standard and is a new option for saving your document as a web p
Outputting to a WebCGM file however does have some limitations

• Only supports four fonts.  The fonts are Times Roman, Helvetic
Courier and Symbol.  Any text exported is converted to use on
of these fonts.

• Gradients are also not supported by the WebCGM profile.  In 
addition, fill patterns are drawn differently by the WebCGM 
viewer.  While the basic pattern is the same, there are differen
that change when you zoom in on a WebCGM metafile.

• Does not support indicators (Shape Numbers and Notes).
• Does not support departments or phases.
• Does not support rotated text.
If you save to WebCGM, you may not have the correct viewer 
installed on your machine to view the output correctly. If you recei
the following message, please go to our site to download the brow

Tables The Web browser should support tables because th
HTML output makes extensive use of tables in the 
navigation elements and in the report output. 
Particularly recommended is a Web browser that 
supports color in table backgrounds.
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This image has been saved in WebCGM (Web Computer Graphic
Metafile) format. To view the image, please install the free 
ActiveCGM Browser available at www.micrografx.com/resources/
activeCGM.asp.

Understanding HTML Naming Conventions

When outputting components (diagrams, scenarios, or reports) to
HTML, it is important to understand how they get named. Two optio
are available for naming your HTML documents:

Option Description
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Filenames

The default setting in the �	)��	������&	'� dialog 
box outputs components using long filenames (the 
original names of your diagrams, scenarios, or report
This helps manage and organize your HTML files 
better, and publish to mediums that do not support no
8.3 names. A few exceptions exist when using long 
filenames:

• Characters not legal in filenames or URLs are 
replaced with an underscore (“_”) Legal 
characters include: A-Z, a-z, 0-9, and the symbols
$-_@.&+-!(),”.

• Cases may occur in a document(s) where two 
components share the same filename. If this 
conflict occurs, the diagram, scenario, or report in
question defaults to the component name.

If a component has more than one page, subsequen
pages use the original name followed by an undersco
and a page number. For example, Inventory_p2. 
Multiple graphics converted to GIF files are labeled in
the same manner.

Not using 
long file 
names

If you clear the 9������'������	����option, any 
components with names over 8 characters are replac
with a default name. For example, if you have a 
diagram named businessprocess within your docume
it will output as dgm1.htm
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Automatic Recovery

FlowCharter 2000 Professional includes a feature that saves the 
diagram or document that you are working on automatically at a s
time increment. Automatic Recovery protects your work from an 
unexpected system or program failure.

To save a document or template

1 On the ���� menu, click �	)�. If you are saving a file for the first 
time, the �	)��*� dialog box opens. If you have already saved 
the file, your changes are saved in the file you named earlier.

2 Type the file name in the�������	�� box.

3 Choose the drive and directory in which you want to store the 
file.

4 Choose the file format (document or template) in the �	)��	��

�+�� box.

Tips
You can also use the shortcut key: CTRL+S.

A template includes all document settings and styles.

You cannot use templates created in FlowCharter 2000 Professional i
earlier versions of FlowCharter. Instead you must save them as FLO o
AF3 files and convert them to templates within those applications.
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To save a copy of a document

1 On the ���� menu, click �	)��*�.

2 Type a file name for the document copy. Use a different name 
distinguish between the copy and the original.

3 Choose the drive and directory in which you want to store the 
copy.

4 Click�
�.

To save a workspace

1 On the �����menu, click �	)����
0��	 �.

2 Type a name for the workspace file in the ������	�� box.

3 Choose the drive and directory in which you want to store the 
workspace file.

4 Click 
�. 

Note
Only saved documents are included in the workspace file. If any of the
documents in the workspace have not been saved, the Save File dialo
box opens to save them.
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To reopen the workspace

1 On the ���� menu, click 
���.

2 Choose ��
0��	 � in the �������#��+������.

3 Choose the drive and directory that contain the workspace file
you want.

4 Click the file you want to open.

5 Click 
�.

To save documents in FlowCharter 7 format

1 On the ���� menu, click �	)��*�.

2 Choose the Micrografx FlowCharter 7.0 File (FLO) format in th
�	)��	���+�� box.

3 Type the file name you want in the ���� name box.

4 Choose the drive and directory where you want to store the file

5 Click 
�.

To save a diagram as a Web page

1 On the����� menu, click �	)��	������&	'�.

2 Choose the folder location to save the page(s).

3 Select the diagram(s) and components to save.
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4 Choose if you want to output diagrams as Java applets, outpu
shape notes, save linked FlowCharter 2000 Professional 
documents, or use long filenames.

Tip
If you are not outputting diagrams as Java applets, you can save 
multiple-page diagrams to a single HTML page by selecting the 
Save Multiple-Page Diagrams to a Single HTML Page check 
box. For example, if you have three diagrams in a document and 
select this option, all three diagrams will appear on one HTML 
page which makes it easier to print from your browser.

5 Click 
�.

The �	)��*������&	'�:��������! dialog opens.

6 Click ����� or click ���� to view the page(s) in your Web 
browser.

To set the automatic recovery time

1 On the ����� menu, click 
������.

2 In the 
�������dialog box, click the "���
	� tab.

3 Select �	)��*������ �)�
 info.

4 In the ���� select box, type an increment between I and 15 
minutes.

5 Click 
�.
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Distributing Documents

Distributing documents to team members, departments, and even 
companies is a great way to communicate ideas and tasks. With 
FlowCharter 2000 Professional, you have three ways to do this:

• Using iGrafx Share
• Sending documents as e-mail attachments
• Sending documents as HTML or Java applets

Using iGrafx Share Viewer

iGrafx Share Viewer contains many features that help you and you
coworkers easily collaborate about a diagram.

When you add markups using Viewer, they are displayed when yo
open them in FlowCharter 2000 Professional.

With iGrafx Share Viewer, you can:

• Open and view multiple diagrams.
• Add markups to a diagrams.
• Page tabs let you navigate with ease in multiple-page diagram
• Share Viewer remembers which markups belong to each 

reviewer.
• View markups by all reviewers, a particular reviewer, or view 

only your own markups.
• Edit text and marker colors.
• E-mail a diagram that contains your markups.
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Sending Documents as E-mail Attachments

FlowCharter 2000 Professional works with any MAPI E-Mail syste
such as Microsoft Outlook, allowing you to send documents as 
attachments with e-mail messages. The Send command automat
opens your e-mail and attaches the open document, so you can ad
and send the mail like any other message.

To open iGrafx Share Viewer

On the ���!������	
� menu, point to �"
	#�, and click ��	
��
�����
.

To send a document as an e-mail attachment

1 Open the document to attach to an e-mail message.

2 On the ���� menu, click ���!.

3 Address the e-mail and create a message as you usually do.

Notes
This feature works with any MAPI E-mail system. MAPI e-mail 
systems include Microsoft Mail, Microsoft Exchange, and Lotus 
cc:Mail.

If the mail system is not running, it starts when you click the Send 
command.
� � � � � � � � � � � � � � � � � � � 
 � � � � � � � � �  90



Previous Page Next Page
iGrafx
S Y S T E M Home Index

te 
 
ize of 

se 
nd 
Setting Up a Diagram

Setting Up the Diagram Page

With almost unlimited diagram space on the screen, you can crea
very large, in-depth diagrams without getting a clear idea of where
page breaks occur, the placement of headers and footers, or the s
your margins.

This becomes important when you need to print diagram pages. U
the &	'� ����� dialog box to adjust page options such as scaling a
page order so a diagram prints correctly.

To define the page setup

1 On the ���� menu, click &	'�������.

2 Click each tab, and select the page setup options you want.

3 Click 
�.

To select the diagram orientation

1 On the ���� menu, click &	'�������.

2 Select &�
�
	�� or �	�!� 	��.

3 Click 
�.
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To set diagram scaling

1 On the ���� menu, click &	'�������.

2 Select *!;������, and type a percentage in the normal size box

or

���� ��������, and type a number of pages wide by a number o
pages tall.

3 Click 
�.

To set the paper size

1 On the ���� menu, click &	'�������.

2 Select a paper size from the &	��
����� list.

or

Type a paper width in the ��!�� box, and a paper height in the 
6��'�� box.

3 Click 
�.

To set page margins

1 On the ���� menu, click &	'�������.

2 Click the �	
'�� tab.

3 Select each of the Margin boxes individually and type the marg
you want.
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4 Click 
�.

Note
FlowCharter 2000 Professional rounds the numbers to the nearest 
hundredth of an inch or tenth of a centimeter. To switch between 
inches and centimeters, right mouse click on the ruler, and click eithe
Inches or Centimeters.

To set diagram titles

1 On the ���� menu, click &	'�������.

2 Click the 
������ tab.

3 To print out large multi-page diagrams that you can cut and tap
together, select &����
���!�, and set the overlap for extra taping
room.

or

To print out multi-page diagrams that you can bind in a book, 
select (��0���!�.

To set the Print Frame option

1 On the ���� menu, click &	'� �����.

2 Click the 
������ tab.

3 Select (��0���!�.

4 Select the �
	�� option.
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To set the Print Notes option

1 On the ���� menu, click &	'�������. 

Note
Notes print after the pages of the diagram print. Notes use shape 
numbers to reference back to shapes in the diagram.

2 Click the 
������ tab.

3 Select the ����� box.

4 Click 
�.

To set the page order for printing

1 On the ���� menu, click &	'�������.

2 Click the 
������ tab.

3 Select ����<������* 
��� to print top to bottom and left to 
right.

or

Select * 
���<���������� to print left to right and top to 
bottom.

4 Click 
�.
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Using Headers and Footers

Headers and footers help you and those who view your diagrams

• Get information about a diagram using names and page numb
• Keep up with revisions and diagram opening and saving using

date and time stamps.

With FlowCharter 2000 Professional you can insert default header
footer information or create custom headers and footers.

To insert a predefined header or footer

1 On the File menu, click &	'�������.

2 Click the 6�	!�
=�����
 tab.

3 Select a style and position combination from the 6�	!�
 list.

4 Select a style and position combination from the �����
 list.

5 Click 
�.

To create a custom header or footer

1 On the ���� menu, click &	'�������.

2 Click the 6�	!�
=�����
 tab.

3 Click �������6�	!�
 or ������������
.
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4 To insert the header or footer information you want in each 
section, click inside ��#���� ����, �����
��� ����, or ��'���
�� ����, and then click the buttons.

Note
To add additional text to the header or footer, enter the text in 
the Left Section, Center Section, or Right Section box.

Using Guidelines and Grids

You can use guideline and grid options in FlowCharter 2000 
Professional to improve the look of your diagram.

Guidelines

You can use guidelines to align objects. When you drag a shape n
guideline, the shape’s sides and center snap into alignment with t
guideline. Guidelines help you align shapes of different sizes to 
achieve an attractive, organized look. Guidelines do not appear in
printed diagram.
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Grids

Grids also help you with alignment by snapping shapes to a serie
snap points on the diagram space. When grid snapping is turned 
every shape that you move locks on to these points. If you open a
diagram and see that objects are not organized and neat, this cou
an indication that grid options were not used. Use the ��	��
�;� ���

���"
�! command on the *

	�'� menu to organize these objects in
the diagram. You can also find the following grid options in the 
*��'����� tab by clicking the 
������ command on the ����� 
menu:

• Snap to Grid—Select this option to snap your objects to grids.
• Show Cross Hairs When Moving Objects—This option shows 

two gray cross hairs, one vertical and one horizontal, when yo
move a shape from one location to another.

To add a horizontal guideline

1 On the *

	�'� menu, point to "��!������, and click *!!�
6�
�����	��"��!�����.

2 Position the guideline by dragging, and click in the diagram 
space.
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You can also click the horizontal ruler, and drag a guideline dow
to the desired position in the diagram.

Tip
You can add a guideline with a right-mouse click. Right-mouse click 
in the ruler area, and click Add Horizontal Guideline.

To add a vertical guideline

1 On the *

	�'� menu, point to "��!�����, and click *!!�
��
�� 	��"��!�����.

2 Position the guideline by dragging, and click in the diagram 
space.

You can also click the vertical ruler, and drag a guideline acros
to the desired position in the diagram.

Tip
You can add a guideline with a right-mouse click. Right-mouse click 
in the ruler area, and click Add Vertical Guideline.

To move a guideline

1 Point to the guideline you want to move.

2 Press and hold the left mouse button, and drag the guideline 
where you want it.
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3 When you are finished, release the mouse button.

To delete a guideline

1 Click the guideline you want to delete.

2 Press and hold the left mouse button.

3 Drag horizontal guidelines to the horizontal ruler, or off the 
bottom edge of the window. Drag vertical guidelines to the 
vertical ruler, or off the right edge of the window.

4 When the guideline pointer is positioned over the appropriate 
ruler, release the mouse button.

To turn on grid snapping

On the *

	�'� menu, point to "
�!, and click ��	�����"
�!.

To show grid dots

On the *

	�'� menu, point to "
�!, and click �����"
�!�����.
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To snap objects to the grid

On the *

	�'� menu, point to "
�!, and click ��	��
�;� ����������
"
�!.

Tip
To set the grid spacing, click the Options command on the Tools menu
and then click the Alignment tab.

Setting Up Departments

You can use departments to display the flow of information and 
materials between different roles, groups or organizational units. I
process diagramming, departments help show how tasks flow thro
groups such as manufacturing and customer service toward a fina
outcome or creation of a product. Many processes contain 
subprocesses that appear in their own departments.

Shapes behave the same in departments as they do on a normal 
diagram page. You can still connect lines, edit points, size, move, 
delete, change the text, or change the color of shapes. In addition
can:

• Name departments
• Set the vertical or horizontal orientation of departments
• Expand or shrink departments
• Reorder departments
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• Move the location of department names

When you create departments for the first time in a diagram, you 
set the department orientation and text orientation for headers. Af
you have created your departments, you edit them in the diagram
space. 

Note
When you create a process diagram, FlowCharter 2000 Professional 
inserts one department and a starting point by default.

To insert a department

1 On the 7���
� menu, click ���	
�����.

or

Click the ���	
�����  tool.

2 In the 7���
�����	
������ dialog box, click *!!.

3 In the 7���
�����	
����� dialog box, type a name for the 
department in the �������	
�������	�� field, and click 
�.

4 Click 
�.
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To set the lane orientation of departments

1 Click the ���	
�����  tool.

2 Under ���	
������

����	����, select 6�
�����	� or 
��
�� 	�.

3 Click 
�.

Note
You can only set the lane orientation of departments the first time you
add departments to a diagram.

To set the text orientation of department labels

1 Click the ���	
�����  tool.

2 Under �����

����	����, select 6�
�����	� or ��
�� 	�.

3 Click 
�.

Note
You can only set the text orientation of department labels the first time
you add departments to a diagram.
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To move the location of department names

1 In an active diagram, click a department label.

2 Click the right-mouse button, and click ��
�	� ��	'
	�.

3 In the Process tab, select a name location from the ���	
����� 
�	���*
�	 list.

4 Click 
�.

To add a color, pattern, or gradient to departments

1 In an active diagram, click a department label.

2 In the "	���
+, click the ���� tab, select ���������
, �����&	���
�, 
or ���� "
	!����, and then click a color, pattern, or gradient.

To add borders and dividers to department lanes

1 In an active diagram, click a department label.

2 Click the right mouse button, and click ��
�	� ��	'
	�.

3 Click the (�
!�
� and ��)�!�
� tab, and select the area you 
would like to apply borders or dividers from the list.

4 Select from the various line types, styles, widths, and colors 
available.

5 Click 
�.
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To edit text in department headers

1 Click the department header. 

The cursor changes to a text cursor.

2 Delete the text, and type a new name.

To delete a department

Click the department header, and press �4�4�4.

To reorder departments

1 Click the department header that you want to move.

2 Click any area between the black squares (handles) on the gra
hatched area.

The cursor changes to four arrows.

For horizontal departments, drag the department up or down t
the desired position and drop.

For vertical departments, drag the department left or right to th
desired position and drop.

To change lane margins and minimum lane size

1 In an active diagram, click a department label.

2 Click the right mouse button, and click ��
�	� ��	'
	�.
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3 Click the �	��� tab, and change the bottom margin, end margi
and minimum lane size.

4 Click 
�.

Using Phases

You can use phases, or phase lines, to divide tasks across departm
Since departments already divide groups or units performing a tas
phases help further separate these tasks into time or process orie
segments. For example, you may want to add three phases to a 
production diagram. One phase could be pre-production, the next
production, and the final phase, post-production. Phase lines prov
the visual break for seeing which shapes (and tasks) occur during
which phase.

Note
Phases work only with diagrams containing departments.

To insert a phase line

1 On the 7���
� menu, click &�	��.

2 Depending on the orientation of your departments, drag the lin
horizontally or vertically to place the phase.

3 Click the left mouse button.
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4 Repeat steps 1-3 to place additional phases.

Note
You can resize or expand the phase by clicking on a black box 
handle and dragging the phase horizontally or vertically.

To format a phase line

1 Using the right mouse button, click a phase.

2 Click ��
�	����	'
	�.

3 In the ��
�	����	'
	� dialog box, click the &�	��� tab.

4 In the &�	����	���*
�	 list, click �� �	��, �	���������, 
�	�� ���(�����, or �	�������	�!�(�����.

5 To change your end style to an arrow, select the button next to 
arrow.

6 Click 
�.

Note
You can also change the border and divider line type, width, and 
color of phase lines. To do this, click the Borders and Dividers 
tab in the Format Diagram dialog box, and select Phase Line 
and/or Phase Divider in the Apply to list.
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To label a phase line

1 Click the phase.

The pointer changes to a text cursor.

2 Click before the word “Phase” and continue to press �4�4�4 
until the text is deleted.

3 Type a new label.

Note
You can also change the color of the phase. To do this using the 
right mouse button, click the phase, click Format, and choose a 
fill style and color.

To delete a phase line

1 Click the phase.

2 Press �4�4�4.
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Working with Shapes and Lines

Using the Shape Library

The Shape Library is a custom collection of shapes that you can se
In the Shape Library, you can store shapes that you use most ofte
default, the Shape Library has the Process shape already in it.

In the Shape Library you can:

• Add additional shapes
• Modify the properties of the shapes
• Remove shapes
• Duplicate shapes
• Change the order of the shapes (move up or down)
• Update shape properties
� 
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Any shapes defined with attributes and formatting that you add to 
diagram become part of the Shape Library. Shapes that you add t
Shape Library using the ������� toolbar are also unique to each 
diagram. Saving a diagram saves the shapes that you add to the 
Library. Also, saving a diagram as a template is a good way to use
extensive Library more than once.

Tip
You can always copy shapes to the Shape Library directly from Share
Media.

As you work with a saved diagram, you might find that you use so
shapes more than others. In this case, you can have these shape
appear in the most convenient areas of the Shape Library. You als
might want to organize related shapes together in the Library. You
easily arrange shapes any way you want by moving them up or do

After you have added shapes to the Library, you can modify them
editing connect points, adding text layouts, adding VBA code, add
modeling properties, and changing default formats and fields.
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To add a shape to the Shape Library

1 On the ������� toolbar, click the ��
����	���  tool.

Note
This tool appears under the last shape you added in the Toolbox 
toolbar.

2 To open the ��	������
	
+ dialog box, click the ��	������
	
+ 
command on the flyout menu.

3 In the ��	������
	
+ dialog box, click *!!���	���.

4 Select a subject from the ��	
� ��!�	 list.

5 Click the ��	�� &	�����.

6 Use the scroll bar in the ��	
����!�	 area to scroll through the 
shapes in the subject.

7 Click the shape you want to add, and then click Add.

8 To add more shapes, repeat steps 4 through 7.

9 Click �����.

To add a shape to the Toolbox toolbar

1 On the ���� menu, click ��	������
	
+.

2 In the ��	������
	
+ dialog box, click the box to the left of the 
shape you want to add to the ������� toolbar.
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3 Click �����.

To remove a shape from the Shape Library

1 On the ���� menu, click ��	������
	
+.

2 In the ��	������
	
+, click the shape you want to remove.

3 Click ����)�.

4 Click �����.

Note
You can only remove a shape from the Shape Library if it is not being
used by the document.

To edit a shape in the Shape Library

1 On the ���� menu, click ��	������
	
+.

2 In the ��	������
	
+, click the shape you want to edit.

3 Click 4!��.

Tip
After you have added shapes to the Library, you can modify 
them by editing connect points, adding text layouts, adding 
VBA code, adding modeling properties, and changing default 
formats and fields.

4 In the 4!�����	�� dialog box, click �+����.
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5 In the 4!����+���� dialog box, click the tabs and make the 
changes.

6 Click 
�.

To duplicate a shape in the Shape Library

1 On the ���� menu, click ��	������
	
+.

2 In the ��	������
	
+, click the shape you want to duplicate.

3 Click ����� 	��.

You can duplicate shapes to edit the attributes and formatting 
shapes that might look similar behave differently.

4 Click �����.

To arrange shapes in the Shape Library

1 Click the shape you want to move.

2 Click ��)��9� or ��)������.

3 Repeat steps 1 and 2 until the shapes are in the order you wa

4 Click �����.
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Placing Shapes in a Diagram

Because you use many shapes when creating a diagram, several
methods exist for placing shapes.

• Placing multiple shapes of the same type—You can place 
multiple shapes of the same type without having to select the 
same shape in the Shape Library again. To do this, place a sh
in the diagram space, click anywhere in the diagram, and then
place another shape.

• Placing multiple types of shapes—You can select each shape 
the Shape Library one at a time to place in the diagram space

You can place shapes in a diagram two ways:

• Using the Shape Library
• Using the Share Media Subject tabs

Note
Double-clicking on a shape in the Toolbox toolbar lets you place 
multiple shapes of the selected type without having to place a shape,
click in the diagram space, and then place another shape. You can 
point and click. This also makes the Finished button appear.
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Shape Library

Placing shapes using the Shape Library requires using two toolba

������� toolbar- This toolbar contains the process shape by defa
and any shapes you designated in the ��	�������
	
+ dialog box to 
appear on the toolbar. Click the arrow below the last shape to ope
��
����	��� flyout menu.

��
����	��� toolbar- This toolbar contains the rest of the shapes y
added to the diagram using Share Media. It also contains the ��	���

���
	
+ command for opening the ��	������
	
+ dialog box.

Share Media Subject tabs

The Gallery contains ��	
����!�	����;� � tabs. You can place 
shapes in a diagram using these tabs. After you open Share Medi
select a subject to create a tab, click the shapes and drag them to
diagram space. To open Share Media, click the ��	���&	������  

tool on the ��	�!	
! toolbar.

To place a shape using the Shape Library

1 Click the shape on the ������� toolbar or the ��
����	��� 
flyout menu that you want to place.

2 Click in the diagram where you want to place the shape.
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To place a shape using the Gallery

1 Click a ��	
����!�	����;� � tab in the Gallery.

2 Click a shape in the palette.

3 Click in the diagram.

Connecting Shapes with Lines

The type of line that you draw is indicated by the ����� ��
�������

tool selected in the ������� toolbar. Select the line type that you wan
to draw by clicking the arrow under the ����� ��
������ tool, and 
then selecting the line from the flyout menu.

You can use any of the six line (routing) tools to connect shapes:

• Direct Line
• Right Angle Line
• Curved Line
• Org Chart Line
• Cause and Effect Line
• Lightning Bolt Line

You can connect lines by dragging or clicking, and connect two sha
with a line. When you connect the shapes with a line, the end poin
the line snap to the nearest connect points in the shapes.
� 
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Using Connector Lines

Connector lines automatically display and snap to points on close
shapes. After placing a connector line, you can easily detach it an
reattach it at a different snap point. When you attach connector line
a shape, you can move the shape and the lines remain attached.

The boxes in this chart are 
connected with connector lines.

The line remains connected to 
the box when the box is moved.
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Setting Off-Page Connectors on Connector Lines

When working with large diagrams spanning many pages, you mi
want to use off-page connectors to keep shapes and lines organiz
You can add an off-page connector to a line manually by using a r
mouse on the line, and then clicking the ��
�	� command. In the 
��
�	������ dialog box, click the *

��� 	�!��
����)�
� tab, and 
select the ����� ��
� box.

Note
In the Format Line dialog box, you can change the color and line style
for a selected line.

You can also set automatic off-page connectors for all lines that b
between pages. On the ��
�	� menu, click the ��	'
	� command, 
and then click the 
##:&	'������� ��
� tab. In the 
##:&	'��
����� ��
� tab, you can set automatic connectors and choose 
options such as directional symbols and page numbering.

To connect two shapes by dragging

1 Make sure that you select the desired������ ��
������  tool 

in the ������� toolbar�

2 Point inside the first shape, press and hold the left mouse butt
then drag the pointer to the side of the first shape where you w
the line to begin.
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3 Trace the path you want the line to follow by dragging the point
to the side of the second shape where you want the line to end

4 Release the mouse button.

Note
Double-clicking on a line in the Toolbox toolbar lets you connect 
multiple lines of the selected type without having to click a line, 
connect a line, and then connect another line. You can point and draw
This also makes the Finished button appear.

You can also draw lines that connect to other lines or lines that remai
unconnected. On the Tools menu, click Options, and then click the 
Connector Lines tab. Select the Allow lines to connect to other lines 
box and Allow unconnected lines box.

To connect two shapes by clicking

1 Click the ����� ��
������  tool.

2 Click the side of the shape from which you want to start the lin

3 Without clicking the mouse, move the pointer to a connect poin
on the shape to which you want to connect the line.

4 Click the connect point. 

A red box on both shapes indicates the connect points that yo
selected on each shape.
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To move a line end from one connect point to another on a shape

1 Select a line connected to a shape.

Two red boxes appear on each end of the line.

2 Move the cursor over the line end that you would like to move 
another point.

3 Click and hold the left mouse button down, and then move the
line end to a new connect point

4 Release the left mouse button.

To edit connect points between shapes

1 In the ��	������
	
+ dialog box, select the shape you want to 
edit.

2 Click 4!��.

3 Click �+����.

4 In the 4!�� symbol dialog box, click the ����� � &����� tab.

5 Use the ��!� or * ����� options to add or delete connect 
points.

To connect two shapes using the Connect Shapes command

1 Click and hold the left mouse button down, and draw a boundin
box around the shapes you want to connect.

2 Click the line type you want.
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3 On the *

	�'� menu, click ����� ����	���.

To reverse line ends between shapes

1 Click and hold the left mouse button down, and draw a boundin
box around the shapes with a line you want to reverse.

2 On the *

	�'� menu, click ��)�
�� 4�!�.

To choose line routing types

1 Click the ����� ��
������  tool.

2 Click the type of line you want. There is a tool for each type.

Tip
To define a frequently used line type and style combination, add a 
preset style.

Direct Line Right Angle Line Curved Line

Org Chart 
Line

Cause and Effect 
Line 

Lightning 
Bolt
� 
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To add a vertex to a line

1 Click either the direct line or the right angle line between two 
shapes.

2 Click the right mouse button, and then click *!!���
���.

An X appears on the line.

3 Slide the X on the line to the position you want.

4 Click the line.

A black box appears at the vertex point.

5 To create the new line bend, click and move the black box.

6 Release the left mouse button.

Note
If you move connector lines manually, you can automatically restore 
them to their original position. To move lines back to their original 
position, right-mouse click on the line, and then click Route Line.

To restore automatic line routing

1 Right-mouse click the right angle connector line.

2 Click ����������.

3 To finish the line move, click in the diagram space.
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To add manual off-page connectors to a line

1 Click on a line.

2 Click the right mouse button, and click ��
�	�.

3 In the ��
�	�������dialog box, click the *

����	�!�

�
����)�
� tab, and then select the ����� ��
� box.

4 Click 
�.

Note
You can also set automatic off-page connectors for all lines that 
break between pages. On the Format menu, click the Diagram 
command. In the Format Diagram dialog box, click the Off-Page 
Connectors tab to set automatic connectors and choose options 
such as directional symbols and page numbering.

Formatting Shapes and Lines

Using the formatting options in FlowCharter 2000 Professional he
you create diagrams that look professional and communicate the 
message that you are trying to send.

Formatting options for shapes and lines appear on the ��
�	� menu, 
the ��
�	����' toolbar, and the "	���
+. You can also use the ��	�� 
���
	
+, ��	
� ��!�	, and the ��#	���� tab on the���
�	��

��	'
	� dialog box to set formatting options. 
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Applying Fill Formats

You can use different colors and fill patterns to differentiate flows a
to identify individual shapes. For example, you could use a cross-
hatched gray fill to identify incomplete processes and a solid yello
fill to identify completed processes.

Applying Line and Border Formats for Shapes

You can choose different line styles for shape outlines. Shape line
include not only the outside part of a shape, but also any interior l
used in the shape and any exterior lines connected to a shape. Th
are many useful line styles for outlines, including solid, dashed, an
center lines.

Applying Line Formats for Lines

You can use a number of styles for lines, including solid and dash
lines. Line styles are commonly used in flowcharts to convey the 
following information.

Line Style Meaning

Solid lines with 
arrows

Show data flow.

Dashed lines Represent multiple transitions and optional 
steps.
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You can choose different line weight and colors for each line and 
arrowhead. Varying line weights distinguish data flows and draw 
attention to certain transitions or data transfers in a diagram.

Applying Arrow and Crossover Formats

Arrowheads help indicate direction. FlowCharter 2000 Professiona
provides two ways to use directional line arrows: 

• Source Arrows
• Destination Arrows

Many beginning and ending arrow styles exist for both source and
destination ends. Try using color to enhance your diagram. You co
use one color for all beginning arrowheads and another for all end
arrowheads.

Center lines Heavier weight lines that represent enclosure 
outlines or draw attention to a specific diagram
element.
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With crossovers, you can set the style and size when lines cross o
each other. You can choose from five different styles of crossovers
you do not choose a crossover style, the lines cross with no indica
which can make it difficult to tell which lines connect to which shap

You can specify the crossover style of individual lines. If you have
bunny-hop line over a broken line, both the bunny hop and the ga
appear. If you have a bunny-hop line under a broken line, two soli
lines appear. In general it is best to use one crossover style throug
your diagram.

Tip
When you draw a line that crosses any existing lines or shapes it goe
over the lines or shapes. To send the line to the back, click it, click the
Arrange tool on the Draw toolbar, point to Order, and then click Send
To Back.

Type Description

Bunny 
Hops

If the line is on top, it shows the hop; if it is 
on the bottom, it shows as a solid line.

Broken 
Lines

If the line is on top, it shows as a solid line; 
if it is on the bottom, it shows as a broken 
line.

Solid 
Lines

If the line is on top, it shows as a solid line; 
if it is on the bottom, it shows as a solid line
These cross with no indication.
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You set the style and size of crossovers by clicking������	�!�(�
!�
 
on the ��
�	� menu, clicking the *

����	�!��
����)�
� tab, and 
then selecting the type and size you want. You also can choose th
crossovers style by clicking the �
����)�
�  tool on the �
	� 

toolbar, and then clicking the type you want.

Applying Shadow/3D Formats

You can use shadows and 3D formats as indicators for shapes. Fo
example, shapes with shadows can indicate that a linked diagram
exists from a shape. You can choose over ten positions for the 3D
appearance of your shape.

To add a color, pattern, or gradient to a shape fill

1 Click the shape you want to fill in.

2 On the ��
�	� menu, click ����.

3 In the ��
�	����	�� dialog box, click the ���� tab.

4 Select a solid, pattern, or gradient from the available styles.

5 Click 
�.

Tip
You can also use the Gallery to apply colors and styles.
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To format lines for shape borders

1 In an active diagram, click the shape you want to format.

2 On the ��
�	� menu, click �����	�!�(�
!�
.

3 Select from the various line types, styles, widths, and colors 
available.

4 Click 
�.

Tip
You can also use the Gallery to apply lines and borders.

To format lines

1 In an active diagram, click the line you want to format.

2 On the ��
�	� menu, click �����	�!�(�
!�
.

3 Select from the various line types, styles, widths, and colors 
available.

4 Click 
�.

To choose arrowhead styles

1 Click the line you want to add arrowheads to.

2 On the ��
�	� menu, click �����	�!�(�
!�
.
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3 In the ��
�	������ dialog box, click the *

����	�!�

�
����)�
� tab.

4 Choose either a ���
 ��*

�� line end, a ������	�����*

�� 
line end, or both.

5 Click 
�.

Note
You cannot change arrowhead styles on filled lines.

To choose a line crossover

1 Click the line you want to cross over another line.

2 On the ��
�	� menu, click �����	�!�(�
!�
.

3 In the ��
�	������ dialog box, click the *

����	�!�

�
����)�
� tab.

4 Select a crossover style and size.

5 Click 
�.

To add a shadow or 3D effect to a shape

1 Click the shape you want to add an effect to.

2 On the ��
�	� menu, click ��	!��=>�.

3 Select ��	!�� or�>�.

4 Select from the various styles, depths, and colors available.
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5 Click 
�.

Tip
You can also use the Gallery to apply shadows and 3D effects.

To color a shadow

1 Click a shape.

2 On the ��
�	� menu, click���	!��=>�.

3 Select ��	!��.

4 Select a color from the ����
 list.

5 Click 
�.

Tip
Click Apply to see the results of your changes without closing the 
dialog box.

To change a shadow depth

1 Click a shape.

2 On the ��
�	� menu, click ��	!��=>�.

3 Select ��	!��.

4 Select a new depth from the ����� list.
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5 Click 
�.

Tip
Click Apply to see the results of your changes without closing the 
dialog box.

To change a shadow direction

1 Click a shape.

2 On the ��
�	� menu, click ��	!��=>�.

3 Select ��	!��.

4 Scroll through the ��+�� box and select a new direction.

5 Click 
�.

Tips
Click Apply to see the results of your changes without closing the 
dialog box.

You also can use the Shadow tool on the Draw toolbar to change the
shadow direction.
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Manipulating Shapes and Lines Together

FlowCharter 2000 Professional uses several commands to organiz
look and position of shapes in a diagram. You can find the followin
commands on the *

	�'� menu and in the �
	� toolbar.

Align command

Command Draw 
toolbar

Description

Left Aligns the selected object or objects 
vertically based on their left edges.

Center Aligns the selected object or objects 
vertically based on their centers.

Right Aligns the selected object or objects 
vertically based on their right edges.

Top Aligns the selected object or objects 
horizontally based on their top edges.

Middle Aligns the selected object or objects 
horizontally based on their centers.

Bottom Aligns the selected object or objects 
horizontally based on their bottom edges.
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Make Same Size command

Space Evenly command

Command Draw 
toolbar

Description

Width Makes the selected object(s) the same size
based on their width.

Height Makes the selected object(s) the same size
based on their height.

Both Makes the selected object(s) the same size
based on their width and height.

Fit to Text Makes the selected object(s) the same size
based on their text.

Command Draw 
toolbar

Description

Across, 
Centers

Spaces the selected object or objects evenl
across the diagram based on their centers.

Down, 
Centers

Spaces the selected object or objects evenl
down the diagram based on their centers.

Across, 
Edges

Spaces the selected object or objects evenl
across the diagram based on their edges.

Down, 
Edges

Spaces the selected object or objects evenl
down the diagram based on their edges.
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Rotate/Flip command

Order command

Command Draw 
toolbar

Description

Rotate 
Right

Rotates the selected object or objects 90 
degrees to the right.

Rotate Left Rotates the selected object or objects 90 
degrees to the left.

Angle Selects the angle and direction for the obje
you want to rotate.

Flip 
Horizontal

Flips the selected object or objects 
horizontally.

Flip Vertical Flips the selected object or objects verticall

Command Draw 
toolbar

Description

Bring to 
Front

Moves the selected object or objects in fron
of other objects in the diagram.

Send to 
Back

Moves the selected object or objects behind
other objects in the diagram.

Send 
Backward

Moves the currently selected object one leve
toward the back.
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Combine command

Bring 
Forward

Moves the currently selected object one leve
toward the front.

Command Draw 
toolbar

Description

Group Groups selected objects.

Ungroup Ungroups selected objects

Connect 
Closed

Connects the selected objects and closes a
objects opened during the process.

Connect 
Open

Connects the selected open objects.

Disconnect Disconnects the selected connected objec

Join Creates a new shape by joining the selecte
objects together.

Intersect Creates a new shape from the intersection
the selected objects

Outline Creates a new shape from the outline of the
selected shapes.

Slice Slices the selected closed shape with the 
selected open shape.
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The Arrange menu also contains time-saving commands that turn
multiple step operations into one step.

To align objects

1 Click the objects you want to align.

2 On the *

	�'� menu, point to *��'�, and click ��#�, �����
, 
��'��, ���, ��!!��, or (�����.

Tips
You can use the following shortcut keys for aligning shapes: Align 
Top (CTRL+SHIFT+4), Align Middle (CTRL+SHIFT+6), Align 
Bottom (CTRL+SHIFT+8), Align Left (CTRL+SHIFT+ 3), Align 
Center (CTRL+SHIFT+ 5), and Align Right (CTRL+SHIFT+ 7).

You can also use the align tools (Align Left, Align Center, Align 
Right, Align Top, Align Middle, or Align Bottom) on the Draw 
toolbar.

Command Description

Connect Shapes Connects selected shapes with a connector 

Replace Shapes Replaces a selected shape with a shape from
Share Media or the Shape Library.

Reverse Ends Reverses the line ends between two selected
shapes.

Fit to Text Fits a select shape to text typed in the shape.
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To make objects the same size

1 Click the objects you want to make the same size.

2 On the *

	�'� menu, point to �	0���	�������, and click 
��!��, 6��'��, (���, or �����������.

You can also use the �	0���	��������tools on the �
	� 
toolbar.

To space objects evenly

1 Click the objects you want to space evenly.

2 On the *

	�'� menu, point to ��	 � 4)���+, and click 
* 
���<������
�; ����<������
�; * 
���<�4!'��; or ����<�

4!'��.

You also can use the ��	 ��4)���+�* 
���<������
�; ��	 ��
4)���+�����<������
�; ��	 ��4)���+�* 
���<�4!'��; and 
��	 ��4)���+�����<�4!'�� tools.

To rotate an object

1 Click the object you want to rotate.

2 On the *

	�'� menu, point to ���	��=����, and click either 
���	�� ��'�� or ���	�� ��#�.

You can also rotate the object by clicking the ���	�����'�� tool 
or the ���	�����#� tool on the �
	� toolbar.
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To rotate an object by angle

1 Click the object you want to rotate.

2 On the *

	�'� menu, point to ���	��=����, and click *�'��.

To select the angle and direction for rotating an object

1 On the *

	�'� menu, point to ���	��=����, and click *�'��.

2 Type a number to determine how much your object is rotated.

3 Select either clockwise or counter-clockwise for the rotation 
direction.

4 Click 
�.

To flip an object

1 Click the object you want to flip.

2 On the *

	�'� menu, point to ���	��=����, and click either 
���� 6�
�����	� or ���� ��
�� 	�.

On the �
	� toolbar, click either the �����6�
�����	� tool or the 
���� ��
�� 	� tool.

To bring an object to the front

1 Click the object you want to bring to the front.

2 On the *

	�'� menu, point to 

!�
, and click (
��'����
�
���.
� 
 � � � � � � � � � 
 � � 
 � � � � � � � � � � � � � �  137



Previous Page Next Page
iGrafx
S Y S T E M Home Index
3 The selected object appears in front of all overlapping objects.

To send an object to the back

1 Click the object you want to move to the back.

2 On the *

	�'� menu, point to 

!�
, and click ���!����(	 0. 
The selected object appears behind all overlapping objects.

To group objects

1 Click the shapes you want to group.

2 On the *

	�'� menu, point to �������, and click "
���.

To ungroup objects

1 Click the shapes you want to ungroup.

2 On the *

	�'� menu, point to �������, and click 9�'
���.

To connect closed objects

1 Click the closed objects you want to connect.

2 On the *

	�'� menu, point to �������, and click ����� ��
�����!.

Tip
You can also use the Connect Closed  tool on the Draw toolbar.
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To connect open objects

1 Click the open objects you want to connect.

2 On the *

	�'� menu, point to �������, and click ����� � 

���.

Tip
You can also use the Connect Open  tool on the Draw toolbar.

To disconnect objects

1 Click the object you want to disconnect.

2 On the *

	�'� menu, point to �������, and click 
��� ���� �.

Tip
You can also use the Disconnect  tool on the Draw toolbar.
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To join objects

1 Click the objects you want to join.

2 On the *

	�'� menu, point to �������, and click ?���.

Tip
You can also use the Join  tool on the Draw toolbar.

To outline objects

1 Click the objects you want to use to form your outline.

2 On the *

	�'� menu, point to �������, and click 
������.

Tip
You can also use the Outline  tool on the Draw toolbar.

To intersect objects

1 Click the objects you want to intersect.

2 On the *

	�'� menu, point to �������, and click 7���
�� �.

Tip
You can also use the Intersect  tool on the Draw toolbar.
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To slice objects

1 Click the open object and the closed object you want to use fo
the slice process.

2 On the *

	�'� menu, point to �������, and click ��� �.

Note
Use the Slice command only when slicing an open object through a 
closed object. The Slice command is not available if you select two 
open objects. You can also use the Slice  tool on the Draw toolbar

To replace shapes

1 Click the shapes in the diagram you want to replace.

2 On the *

	�'� menu, click ����	 � ��	���.

3 In the ����	 ����	�� dialog box, find and click the shape you 
want to use as a replacement.

4 Click ����	 �.
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5 Click 
�.

Notes
Any manually resized shape or shape that has been fitted to text mus
be resized after you replace the shape.

When you replace shapes, the new shapes connect to the lines on th
old shapes. The program automatically chooses the closest connect 
point on the new shapes.

FlowCharter 2000 Professional automatically preserves shape 
numbers, colors, borders, patterns, and text size when it replaces the
shape.

To fit shapes to text

1 Click the text block or the shape that contains the text.

2 On the *

	�'� menu, click �����������.

Tip
Press F8 to fit a shape or a text block to text.
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Using Spacing Options Between Shapes

When you connect shapes with right angle lines, you can choose 
far the line segments are offset from the shapes. This feature is u
if the line segments are too short or too long. Your choice affects o
right angle lines. You can set the spacing options in the ����� ��
 
����� tab on the 
������ dialog box.

• Horizontal Spacing- The Horizontal shape spacing option lets 
you set the amount of horizontal space between lines and sha

• Vertical Spacing- The Vertical shape spacing option lets you se
the amount of vertical space between lines and shapes.

To set the line spacing between shapes and lines

1 On the ����� menu, click 
������.

2 If necessary, click the ����� ��
�������tab.

3 Click the 6�
�����	��box, and type the distance you want 
between the shape and the first right angle of a horizontal line
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4 Click the ��
�� 	� box, and type the distance you want between
the shape and the first right angle of a vertical line.

Tips
The measurements used (inches or centimeters) are displayed next t
the box. These measurements apply to the whole diagram. To chang
the type of measurement used, right-click the ruler, and click the 
measurement type you want.

You can also create a toolbar with the inches and centimeters button
To do this, click Tools, click Customize, and click the View category. 
Click the buttons, drag them outside of the Customize dialog box, and
drop them. (When you drop the second button, be sure it is more or 
less on top of the first button. That way, it gets added to the same 
toolbar instead of creating a second toolbar with one button in it.) Now
that you have a toolbar with the inches and centimeter buttons, you ca
click them to change the unit of measurement.

Working with Default and Preset Shape and Line 
Styles

As you create diagrams, you can reuse the same shape and line s
For example, you can use the same border style and fill pattern fo
decision shapes in a certain flow. You can choose the styles you w
to reuse and store them in a list. These styles are called preset st
After saving new preset shape and line styles, you can open them
clicking the ��	�����+�� or �������+�� lists on the &
�������+��� 
toolbar.

You can set and apply shape and line defaults three ways:
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• Defaults tab on the ��
�	� ��	'
	� dialog box
• Preset shape and line styles
• ��	������
	
+ and ��	
����!�	

This list is arranged in order of override capabilities: Preset shape
line styles you create using the &
�������+����toolbar override shape 
and line settings you create using the ��#	���� tab. Defaults you 
create for individual shapes appearing in the ��	�� ���
	
+ and 
��	
� ��!�	 override styles you create using the &
�������+��� 
toolbar and defaults you create using the ��#	���� tab.

To set shape and line defaults using the Defaults tab

1 On the ��
�	� menu, click ��	'
	�, and then click the 
��#	���� tab.

Note
You can set several defaults in this tab. This procedure explains 
how to set one type.

2 Click the ��	��� box, and then click ����.

3 In the ��
�	������ dialog box, choose a fill style or a foreground
color.

4 Click 
�.

5 In the ��#	���� tab, click 
�.

All shapes that you place in the diagram appear with the fill sty
and color you selected.
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To create a new preset shape style

1 Click the 4!�����	�����+���  tool on the &
�������+��� 

toolbar.

2 In the &
�������+��� dialog box, click ���.

3 In the ��
�	�������dialog box, select the shape options that you
want.

4 Click 
�.

5 Type a new name for the shape style.

6 Click 
�.

7 Click 
�.

To add a preset shape style

1 Click the shape in the diagram.

2 Click the *!!���	�����+��  tool on the &
�������+��� 

toolbar.

The shape is added to the���	�����+�� list.

Tip
Click Toolbars on the View menu, and then click Preset Styles to 
display the Preset Styles toolbar.
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To choose a preset shape style

1 Select the shape(s) to which you want to apply the style.

2 Click the ��	�����+��� list on the�&
�������+��� toolbar.

3 Click the shape style you want. 

Notes
If no shape is selected, the preset style appears in the Sample tool an
becomes the current shape style.

If you select a shape before you choose a shape style, the style is 
applied to the selected shape.

Click Toolbars on the View menu, and then click Preset Styles to 
display the Preset Styles toolbar.

To rename a preset shape style

1 Click the 4!�����	�����+���  tool on the�&
�������+��� 

toolbar.

2 In the &
�������+��� dialog box, click the preset shape style you
want to rename, and click ���	��.

3 Type a new name.

4 Click 
�.
� 
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5 Click 
�.

Tip
Click Toolbars on the View menu, and then click Preset Styles to 
display the Preset Styles toolbar.

To delete a preset shape style

1 Click the 4!�����	�����+���  tool on the &
�������+����

toolbar.

2 In the &
�������+��� dialog box, click the shape style you want 
to delete.

3 Click ����)�.

4 Click 
�.

Tip
Click Toolbars on the View menu, and then click Preset Styles to 
display the Preset Styles toolbar.

To create a new preset line style

1 On the &
�������+��� toolbar, click the 4!����������+��  tool.

2 In the�&
�������+��� dialog box, click the ���� tab.

3 Click ���.
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4 In the ��
�	������ dialog box, select the line options that you 
want.

5 Click 
�.

6 Type a new name for the line style.

7 Click 
�.

8 Click 
�.

To add a preset line style

1 Click the line in the diagram.

2 Click the *!!��������+��  tool on the &
�������+��� toolbar.

The line style is added to the �������+�� list.

To choose a preset line style

1 Select the line(s) to which you want to apply the style.

2 Select the��������+��� list on the &
�������+��� toolbar.
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3 Click the line style you want.

Tips
If no line is selected, the preset style becomes the current line style.

If you select a line before you choose a line style, the style is applied to
the selected line.

You can also apply a new line style using the Preset Styles command
on the Format menu.

To rename a preset line style

1 On the &
�������+��� toolbar, click the 4!����������+��  tool.

2 In the &
�������+��� dialog box, click the����� tab, and then 
click the preset style you want to rename.

3 Click ���	��.

4 Type a new name.

5 Click 
�.

6 Click 
�.
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To delete a preset line style

1 Click the 4!����������+���  tool on the�&
�������+����

toolbar.

2 In the &
�������+��� dialog box, click the line style that you 
want to remove.

3 Click ����)�.

4 Click 
�.

To set shape and line defaults using the Shape Library

1 On the ���� menu, click ��	������
	
+.

2 In the ��	������
	
+ dialog box, select a shape in the ��	��� 
list.

3 Click 4!��.

4 In the 4!�����	�� dialog box, clear the 9�����	'
	����#	����

��
�	� box under ��	�����#	����.

5 Click ��
�	�.

Note
You can select several formatting options in the Format Shape 
dialog box. This procedure explains how to set one type.

6 On the ���� tab, select a fill style, and then click 
�.

7 In the 4!�����	�� dialog box, click 
�.
� 
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8 In the ��	������
	
+, click �����.

To set shape and line defaults using Share Media

1 Click a ��	
����!�	 subject tab in the "	���
+.

2 Right-mouse click a shape, and then click &
���
����.

3 In the ��	���&
���
���� dialog box, click 4!��.

4 In the�4!�����	�� dialog box, clear the 9�����	'
	����#	����

��
�	��box under ��	�����#	����.

5 Click ��
�	�.

6 On the ���� tab, select a fill style, and then click 
�.

7 In the 4!�����	�� dialog box, click 
�.

8 In the ��	���&
���
���� dialog box, click 
�.

Working with Shape Fields

In FlowCharter 2000 Professional you can use shape fields to exp
the power of any selected shape. Inserting a field in a shape helps
attach extra functionality to a shape. It also helps users of your 
diagram understand that shapes with fields included give more 
information or perform special functions.
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A shape field can be something simple like a date and time, or 
something more complex, like a Visual Basic expression. The ����

����!�dialog box contains all the field type functions that you can 
include with a shape. This dialog box is dynamic. Depending on w
field type you choose, more information appears on the right side 
the dialog for selecting or changing. After choosing a field type, yo
can also position it at different places inside the shape or outside 
shape’s border.

To add a field to a shape

1 Click the shape you want to add a field to.

2 On the ��
�	� menu, click ����!�.

3 In the���	�������!� dialog box, click ��������!.

4 In the ����!��+�� list, click the plus signs next to the field types,
and click the field you want to insert.

5 Click 
�.

6 In the ��	�������!� dialog box, move the mouse pointer over 
the �� 	���� box. A black dot follows the pointer.

7 Click the field box within the outline of the shape.

8 While holding the left mouse button down, move the field box t
the desired position.

9 Release the left mouse button.

10 Click 
�.
� 
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To move a shape field in or around a shape

1 Click the shape that contains the shape field.

2 On the ��
�	� menu, click ����!�.

3 In the ��	�������!� dialog box, move the mouse pointer over 
the Location box. A black dot follows the pointer.

4 Click the field box within the outline of the shape.

5 While holding the left mouse button down, move the field box t
the desired position.

6 Release the left mouse button.

7 Click 
�.

To include a shape field description with a shape

1 Click the shape that contains the shape field.

2 On the ��
�	� menu, click ����!�.

3 In the ��	�������!� dialog box, select 7� ��!����� 
������.

This places the name of the shape field you use before the ac
shape field. For example, if you include a field code for page 
number, PageNumber: appears prior to the page number with 
selected shape.

4 Click 
�.
� 
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To set the text orientation for a shape field

1 Click the shape that contains the shape field.

2 On the ��
�	� menu, click ����!�.

3 In the ��	�� ����!� dialog box, select one of the text 
orientations under the �� 	���� box.

4 Click 
�.

To set advanced shape field options

1 Click the shape that contains the shape field.

2 On the ��
�	� menu, click ����!�.

3 In the���	�������!� dialog box, click *!)	� �!.

To wrap the shape field description, select �������������!�� 
and change the ��!��.

To hide the shape field from view in or around the shape, sele
6�!� ����.

To prevent a shape’s field text string from being updated if the 
field type is changed, select �
���������.

To delete a shape field

1 Click the shape that contains the shape field.

2 On the ��
�	� menu, click ����!�.

3 In the ��	�������!� dialog box, click ������.
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Numbering Shapes

FlowCharter 2000 Professional has several options for numbering
renumbering shapes in a diagram. You can apply numbering 
commands to individual shapes, all shapes in a diagram, new sha
that you place, or existing shapes in a diagram.

Using numbering commands you can:

• Show or hide shape numbers
• Automatically number shapes
• Manually number shapes
• Change the default number format
• Set an area in a shape where you would like the number to ap

Note
Shape numbering is turned off by default. Before you can make any 
changes to shape numbers, you must select a shape and show its sh
number, or for all shapes, show all shape numbers.
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To show or hide numbers on all shapes

On the ��
�	� menu, point to �����
��', and click �����*���

��	�� �����
� or 6�!��*�����	��������
�.

Note
This feature only affects shapes numbered with the Numbering feature
If you type a number as text in the shape, the number will not be show
or hidden using this method.

To show or hide numbers on selected shapes

1 Select the shapes whose number you want to show or hide.

2 On the ������� toolbar, click the ��	��������
��'  tool.

3 Click �������	��������
 or 6�!����	��������
.

To renumber all shapes automatically

1 On the ��
�	� menu, point to �����
��', and click *��� 
�������
.

2 In the *����	��  �������
 dialog box, select *�����	���.

3 Type a starting number in the ��	
���' �����
 dialog box.

4 Select a renumber style.

5 Click 
�.
� 
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To renumber selected shapes automatically

1 Select the shapes in the diagram you want to renumber.

2 On the ��
�	� menu, point to �����
��', and click *����
�������
.

3 In the *����	�� ��������
 dialog box, select ���� ��! 
��	���.

4 Type a starting number in the ��	
���'������
 box.

5 Click 
�.

To renumber shapes manually

1 On the ��
�	� menu, point to �����
��', and click �	��	� 
�������
. The pointer changes to the �����
 pointer when 
you move it into the drawing area.

2 In the �������
 dialog box, type the next number you want 
displayed.

3 Click the first shape in the diagram you want to renumber.

4 Click the other shapes in the order you want them renumbered

5 In the �������
 dialog box, click �������!.
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To set the default number format for new shapes

1 On the ��
�	� menu, point to �����
��', and click ��#	����
�����
���
�	�.

2 In the ��	�� ����!� dialog box, click ��
�	�.

3 In the �����
��'���
�	� dialog box, select a new example 
number from the 4�	����������
 list. 

Note
You can also type your own numbering schemes directly in this 
list.

4 If you selected a two-part example number, click either the left 
right number or letter to increment.

5 Click 
� to close the �����
��'���
�	� dialog box.

6 Click 
�.

To change the number format for existing shapes

1 On the ��
�	� menu, point to �����
��', and click �����
 
��
�	�.

2 In the ��	�������!� dialog box, click ��
�	�.

3 In the �����
��'���
�	� dialog box, select a new example 
number from the 4�	����������
 list.

4 If you selected a two-part example number, click either the left 
right number or letter to increment.
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5 Click 
� to close the �����
��'���
�	� dialog box.

6 Click 
�.

To set the numbering position in a shape

1 On the ��
�	� menu, point to �����
��'< and click ��#	����
�����
���
�	�.

2 In the ��	�������!� dialog box, move the mouse pointer over 
the �� 	���� box. A black dot follows the pointer.

3 Click the field box within the outline of the shape.

4 While holding the left-mouse button down, move the field box t
the desired position.

5 Release the left-mouse button.

6 Click 
�.

Using Auto Layout

Auto Layout is a feature specific to iGrafx Process 2000 that helps
choose the most logical shape positions and line routings for your
diagram. The result is a clean and concise layout that helps you a
your audience visualize and understand an illustrated concept.

Using Auto Layout you can:

• Specify what style you want to apply to your diagram
• Choose and create specific schemes
� 
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Auto Layout provides four different styles to choose from:

• Hierarchical
• Orthogonal
• Circular
• Symmetric

After you choose a specific style for your diagram, you can further
manipulate the look of your document by using the *!)	� �!�


������ button on the *�����	+��� dialog box.
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Choosing an Auto Layout Style

Some thought should go into choosing an Auto Layout style. Each
style has specific properties and tailoring capabilities that can add
detract from a diagram depending on what you are trying to illustr
Below is a general description of each style.

Style Description

Hierarchical Style The hierarchical style works by 
grouping your diagram into a set of 
levels. These levels can be horizontal or 
vertical depending on the look you are 
trying to achieve.

Hierarchical diagrams are useful when 
creating a number of different diagrams. 
A few include:

• Process modeling
• Project Management
• Work-flow
• Networking
• Telephony
� 
 � � � � � � � � � 
 � � 
 � � � � � � � � � � � � � �  162



Previous Page Next Page
iGrafx
S Y S T E M Home Index
Orthogonal Style The orthogonal style works by 
producing a diagram in which all edges 
run parallel to the (x, y) axis. Auto 
Layout achieves the orthogonal style by 
building the diagram on an invisible 
grid.

Orthogonal diagrams are most useful in 
producing clear, concise diagrams that 
do not show inherent hierarchical 
structures. Some examples include:

• CAD diagrams
• OOA/OOD diagrams
• Electrical diagrams
• CASE diagrams

Circular Style The circular style is designed to layout 
diagrams representing networks, and is 
most useful when designing diagrams 
for:

• Network management
• Social networking
• Criminology
• www visualization
� 
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To apply hierarchical style

1 On the *

	�'� menu, click *��� �	+���.

2 Select 6��
	
 �� 	�.

3 Click 
�.

Note
The hierarchical style is preset (defaults) to set up your diagram in 
proper hierarchical layout. To change this, use the advanced settings
However, it is recommended that you use the proper hierarchical 
layout option.

To apply orthogonal style

1 On the *

	�'� menu, click *�����	+���.

2 Select 

���'��	�.

Symmetric Style The symmetric style works by 
producing a layout that emphasizes the 
symmetries specific to a diagram.

Symmetric diagrams are useful in 
designing layouts of:

• Wide-area networks
• Database schemata
• Semantic networks
� 
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3 Click OK.

To apply circular style

1 On the *

	�'� menu, click *�����	+���.

2 Select ��
 ��	
.

3 Click 
�.

To apply symmetric style

1 On the *

	�'� menu, click *�����	+���.

2 Select �+����
� .

3 Click 
�.

To use advanced auto layout settings

1 On the *

	�'� menu, click *�����	+���.

2 Select the style you want to apply to your diagram.

3 Click *!)	� �!.

4 Make any changes in options necessary.

Tip
To retrieve more information on manipulating a specific style, click 
Help in the Advanced Auto Layout dialog box.

5 Click 
�.
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6 Click 
�.

To save auto layout settings as a scheme for future use

1 On the *

	�'� menu, click *�����	+���.

2 Select the style you want to apply to your diagram (hierarchica
orthogonal, circular, or symmetric).

3 Make any necessary changes in advanced settings.

4 Click 
�.

5 Click �	)��*�.

6 In the �	)��� ���� dialog box, type a name for your scheme.

7 Click 
�.

8 Click 
�.

To select an auto layout scheme

1 On the *

	�'� menu, click *�����	+���.

2 In the � ����� list, click a scheme.

3 Click 
�.

To delete an auto layout scheme

1 On the *

	�'� menu, click *�����	+���.

2 In the � ����� list, click the scheme you want to delete.

3 Click ������.
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Working with Text

Creating and Manipulating Text

Five types of text exist in FlowCharter 2000 Professional:

Text Type Description

Shape Text that you type directly in a shape. As you 
type text, the shape automatically resizes to fit 
the text. You can use the shape text to describe
only that shape.

Department Name Text that you type directly in department 
headers.

Connector Line Decision - Text generated from selections in th
Properties dialog box. You cannot delete this tex
in the diagram space.

Direct - Text that you create by selecting a line 
and typing on it.

General Graphic - Text that you type directly in graphic

Direct - Text that you create by clicking the Tex
tool on the Toolbox toolbar, clicking in the 
diagram space, and then typing.

Field Text that appears as a field in or around a shap
� 
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You can:

• Create freeform text, shape text, and text on lines.
• Create and format callout lines.
• Set the formatting style for text.
• Set the alignment of a text block.
• Create and set tab sizes.
• Set the text orientation.
• Align text.
• Make text a bulleted list and set the bullet style and spacing.
• Rotate text.
• Make text opaque.
• Set tab spacing.
• Modify line spacing between paragraphs, and set the spacing 

units.
• Increase or decrease text indention.

New Text Features

FlowCharter 2000 Professional includes the following new text 
manipulation features:

• Shapes automatically adjust to the text you type. 
• When you click a shape, you can automatically begin typing te

into the shape.
• You can add multiple text fields to a shape.
� 
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You have more formatting options for text in a diagram. You can:

• Make the text a bullet list.
• Set tab spacing.
• Modify line spacing between paragraphs.
• Increase or decrease text indention.
• Set the text orientation.

You have more formatting features that you access directly from th
��
�	����' toolbar. You can:

• Rotate text blocks.
• Make text opaque.
• Increase and decrease indents and line spacing in text blocks

To create shape text

1 Click within the shape that you want to add text to.

2 Type the text you want in the shape. To start a new line, press
4��4�.

3 When you finish typing, click outside the shape.

To edit text in department headers

1 Click the department header. 

The pointer changes to a text cursor.

2 Delete the text, and type a new name.
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To create text in the diagram space

1 Click the ����  tool on the ������� toolbar.

2 Click in the diagram space, and type.

3 When you finish typing, click away from the text.

To add text to a graphic

1 Double-click the graphic. 

2 Type the text in the graphic.

3 To make the text appear in the graphic, click outside of the tex
box.

Tip
You can also use the right mouse menu and click Add Text.

To create text on lines

1 Select the line.

2 Type the text you want. To start a new line, press 4��4�.
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3 When you finish typing, click outside the text block.

Note
You can have text appear next to lines instead of on lines. On the 
Tools menu, click Options, and then click the Connector Lines 
tab. Under Default Text Line Style, click Next to the line. Text 
typed on a line will appear next to it.

To select text

Click the shape or text block you want.

Tips
To select more than one object, Press SHIFT and click. 

FlowCharter 2000 Professional applies any text options you choose t
all the text in the selected objects.

To place the text cursor in text

1 Click the shape (including the text block) that contains the text
you want to change.

2 Point the cursor inside the text you want to change.
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To select text by dragging

1 Click the shape (including the text block) that contains the text
you want to change.

2 Click at the beginning of the text you want to select.

3 Click and hold the left mouse button, and drag across the text y
want. To select multiple lines of text, drag up or down.

4 Release the mouse button when you are finished.

To move the text cursor using the keyboard

1 Select the object containing the text.

2 Click to place the text cursor where you want.

3 Press the right or left arrow keys to move the text cursor one 
character at a time. Press ����8�
�'���	

�� or ����8��#��
	

�� to move the cursor one word at a time. To move the curs
one line, press the up or down arrow keys.

To select text using the keyboard

1 Select the object containing the text.

2 Click to place the text cursor at the beginning of the text you 
want.

3 Press and hold the �67�� key.
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4 Press the right or left arrow keys to select one character at a tim
Press ����8
�'���	

�� or ����8��#��	

�� to select one 
word at a time. To select one line up or down from the text curs
press the up or down arrow keys.

5 Release the �67�� key when you are finished.

To delete text

1 Select the object containing the text.

2 Click to place the text cursor where you want to begin deleting
text.

3 To delete text to the left of the text cursor, press (*���&*�4. To 
delete text to the right of the cursor, press �4�4�4.

Formatting Text

You can choose styles for text in a diagram. Diagram text consists
anything you type in the diagram space, in a shape, in a departme
a graphic, or on a line.

Text Appearance

Formatting text includes changing the way the text looks. By chang
a font size or color, you change the way text appears on the scree
in a printed diagram.
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Text Functionality

Formatting text also determines how text relates to other text. Add
bullets and line indents to a text block helps it look different from 
other text in a diagram. Secondary text areas in shapes create spa
separate pieces of information.

Text formatting commands appear on the ��
�	� menu. You can also
find formatting tools and options on the ��
�	����' toolbar and in 
the Gallery.

To choose text styles

1 Select the text you want to change.

2 On the ��
�	� menu, click ����.

3 In the���
�	������ dialog box, scroll through the font list, and 
select the font you want.

4 To change the font size, scroll through the size list and select t
size you want.

5 To turn text effects on or off, select the box next to (��!, 7�	�� , 
9�!�
����, and ��
�0���
��'�. (You can select more than one.

6 To change the text color, select the ����
 list and select a color.

7 To set the background of the text to opaque, select the 
�	@�� 
box.
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8 Click 
�.

Note
To format field text, click the Fields command on the Format 
menu, select the field, and click Font.

To set bullet styles for text

1 On the ��
�	� menu, click �����*��'�����.

2 In the ��
�	� ���� dialog box, click the &	
	'
	�� tab, and 
select the bullet style from the (����� ��+�� list.

3 Type the number of tabs for the bulleted text list to move to the
right in the Indents box.

Notes
You can also use the Bullets  tool on the Formatting toolbar.

Set the tab spacing (size) in the Block tab.

4 Click 
�.

To set the line spacing for text

1 On the ��
�	� menu, click �����*��'�����.

2 In the���
�	������ dialog box, click the &	
	'
	�� tab.
� 
 � � � � � � � � � 
 � � � � �  176



Previous Page Next Page
iGrafx
S Y S T E M Home Index

 

der 
3 Under 7���
�������	 ��', select the number of lines to space in
the ��	 ��' box, and select ����� or &����� from the ��	 ��'�
9���� list.

4 Click 
�.

You can also use the �� 
�	����������	 ��' and 7� 
�	���
�������	 ��' tools on the ��
�	����' toolbar.

To set text margins inside shapes

1 Click the shape.

2 On the ��
�	� menu, click ������	+���.

3 Select ��	�����#	���, ����!, or &�
 ���	'� from the ��	�� 
�	
'��� list.

4 Type the shape margins for the top, bottom, left, and right.

5 Click 
�.

To add secondary text areas to a shape

1 Click the shape.

2 On the ��
�	� menu, click ���� �	+���.

3 In the ��
�	��������	+��� dialog box, click *!!.

4 Click ��#�, ���, ��'��, or (�����.

The secondary text area appears as the box with the solid bor
around it in the preview shape.

5 In the ���� box, select the size of the text area.
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Note
You can also format secondary areas in the Format Text Area 
dialog box by clicking Format under Selected Text Area.

To delete secondary text areas from a shape

1 Click the shape.

2 On the ��
�	� menu, click ������	+���.

3 In the ��
�	��������	+����dialog box, click the secondary text 
area in the preview shape you want to remove.

4 Click ����)�.

5 Click A4�.

To align text blocks

1 On the ��
�	� menu, click �����*��'�����.

2 In the ��
�	������ dialog box, click the (�� 0 tab.

3 To change the horizontal block alignment, click ��#�, �����
, or 
��'��.

4 To change the vertical block alignment, click ���, ��!!��, or 
(�����.

5 Click 
�.
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To set text orientation

1 On the ��
�	� menu, click �����*��'�����.

2 In the ��
�	� ���� dialog box, click the (�� 0 tab.

3 Under �����

����	����, click the direction you want your text 
oriented.

4 Click 
�.

To rotate text without the shape

1 Click the text block or shape that contains the text you want to
rotate.

2 Click the ���	����������#�  or����	����������'��  tool 

on the ��
�	����' toolbar.

3 Repeat step 2 to continue rotating the text until it is in the 
position you want.

4 Click outside the text area.

To rotate text with a shape

1 Select the text you want to rotate.

2 On the *

	�'� menu, click����	��=����, and then click 
���	�� ��'��, ���	�����#�, or *�'��.
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Working with Default and Preset Text Styles

As you create diagrams, you can reuse the same text defaults an
styles. For example, you can set a default for text appearing only 
shapes, and another default for text appearing on connector lines
Setting defaults for different types of text helps the creator and us
of a diagram understand that text can be used for more than labe
purposes.

You can set and apply text defaults three ways:

• Defaults tab on the ��
�	� ��	'
	� dialog box
• Preset text styles
• ��	������
	
+ and ��	
����!�	

This list is arranged in order of override capabilities: Preset text st
you create using the &
�������+��� toolbar override text settings you
create using the ��#	���� tab. Defaults you create for individual 
shapes appearing in the ��	������
	
+ and ��	
����!�	 override 
styles you create using the &
�������+��� toolbar and defaults you 
create using the ��#	���� tab.
� 
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To set text defaults using the Defaults tab

1 On the ��
�	� menu, click ��	'
	�, and then click the 
��#	���� tab.

Note
You can set several defaults in this tab. This procedure explains 
how to set one type.

2 Click the ��	��� box, and then click ����.

3 In the ��
�	������ dialog box, choose a font from the ���� list.

4 Click 
�.

5 In the ��#	���� tab, click 
�.

All new shapes created will have the default font style applied.

To add a preset text style

1 Select the text with the styles you want (font, size, style, and 
color).

2 On the &
�������+���������	
, click the *!!��������+��  

tool.

Tips
To display the Preset Styles toolbar, use a right mouse click in a 
toolbar area, and click Preset Styles.
� 
 � � � � � � � � � 
 � � � � �  181



Previous Page Next Page
iGrafx
S Y S T E M Home Index
To apply a preset text style

1 Select the text you want to apply the style to.

2 On the &
�������+��� toolbar, select a style from the �����

��+��� list.

To rename a preset text style

1 Click the�4!����������+��  tool on the &
�������+��� toolbar.

2 In the &
�������+��� dialog box, click the style you want to 
rename.

3 Click ���	��.

4 In the ���	�����+�� dialog box, type the new name.

5 Click 
�.

6 In the &
�������+��� box, click 
�.

To delete a preset text style

1 Click the 4!����������+��  tool on the &
�������+��� toolbar.

2 In the &
�������+��� dialog box, click the text style you want to 
delete.

3 Click ����)�.

4 Click 
�.
� 
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To set text defaults using the Shape Library

1 On the ���� menu, click ��	������
	
+.

2 In the ��	������
	
+, select a shape in the ��	��� list.

3 Click 4!��.

4 In the 4!�����	�� dialog box, clear the 9�����	'
	����#	����

��
�	� box under ��	�����#	����.

5 Click ��
�	�, and select ����.

Note
You can select several formatting options in the Format Text 
dialog box. This procedure explains how to set one type.

6 On the ���� tab, select a font from the ���� list, and then click 

�.

7 In the 4!�����	�� dialog box, click 
�.

8 In the ��	������
	
+, click �����.

Note
New shapes added to the diagram space using this shape will 
default to this text style.
� 
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To set text defaults using Share Media

1 Click a Share Media subject tab in the Gallery.

2 Right-mouse click a shape, and then click &
���
����.

3 In the ��	���&
���
���� dialog box, click 4!��.

4 In the 4!�����	�� dialog box, clear the 9�����	'
	����#	����

��
�	� box under ��	�����#	����.

5 Click ��
�	�, and select ����.

6 On the ���� tab, select a font from the ���� list, and then click 

�.

7 In the 4!�����	�� dialog box, click 
�.

8 In the ��	���&
���
�����dialog box, click 
�.

Note
New shapes added to the diagram space using this shape will 
default to this text style.
� 
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Drawing Graphics

Understanding Differences between Graphics and 
Shapes

Understanding the differences between a graphic and a shape he
you use shapes more effectively. In FlowCharter 2000 Professiona
graphics and shapes serve different purposes: Shapes are intellig
and graphics serve as helpers.

The following table describes some differences between graphics
shapes:

Graphics Shapes

Draw using Draw Tool 
options.

Place using the Toolbox toolbar or the 
Gallery.

Do not use connector 
lines. Use callout lines to 
attach graphics to other 
objects.

Use connector lines to connect between
shapes. Connect lines from other shape
to them.

Not intelligent. Cannot 
add fields, custom data, 
VBA code, and other 
shape properties.

Intelligent. Add fields, custom data, and
VBA code.
� � � � � � � � � � � � 
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Things you can do with graphics include:

• Adding text
• Reshaping
• Rotating
• Attaching to shapes using callout lines
• Converting to a shape

As helpers, graphics can add value to shapes by describing what 
shape is and why it is in the diagram. For example, you can use ca
lines to attach a note (a graphic with text) to a shape. Callout lines
attached to shapes from graphics move together as one unit. If yo
move the shape, the graphic moves with it.

Drawing Graphics

FlowCharter 2000 Professional contains several options for drawi
graphical shapes and lines. These options include:

• Square
• Rounded Square
• Rectangle
• Rounded Rectangle
• Circle
• Ellipse
• Polygon
• Smoothed Polygon
� � � � � � � � � � � � 
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• Jointed Line
• Curved Line

All graphics have the same attributes. After drawing a graphic, 
handles (black boxes) appear around it and a red square appears 
of it. 

To open the �
	� toolbar, click the �
	�  tool on the ��	�!	
! 

toolbar.

To view drawing options, click the �
	�  tool on the �
	� 

toolbar.

When you click a graphic option from the �
	� tool, the pointer 
changes to intersecting lines with a small icon of the graphic. You 
draw as many graphics as you want while the pointer is displayed

Tip
You can also tear off the Draw tool and move it into the diagram space
by clicking the Draw tool and moving the pointer to the gray bar at the
top of the flyout. When the bar changes from gray to your system-
defined color, click and hold down the left mouse button and drag the
flyout to the diagram space. After you tear off the Draw tool, you can 
double click a graphic to draw multiple graphics of the same type. 
When you finish drawing the graphics, click the Finished button.
� � � � � � � � � � � � 
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To draw a graphic

1 On the �
	� toolbar, click the �
	�  tool.

2 Click a draw option.

3 Move the pointer to the diagram space, press the left mouse 
button and drag down and to the right.

4 Release the left mouse button.

Manipulating Graphics

After drawing a graphic, you can move it or resize it. You can also
arrange and combine a series of graphics. Graphics share some o
same features as shapes such as adding text and rotating. You ca
reshape a graphic using points and convert a graphic to a shape.

To add text to a graphic

1 Double-click the graphic. 

2 Type the text in the graphic.

3 To make the text appear in the graphic, click outside of the tex
box.

Tip
You can also use the right mouse menu and click Add Text.
� � � � � � � � � � � � 
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To move a graphic

1 Click the graphic.

2 Move the pointer to the gray hatched area surrounding the 
graphic.

The pointer changes to four arrows.

3 Click the gray hatched area and drag the graphic to a new 
position.

4 Release the mouse button.

To resize a graphic

1 Click the graphic.

2 Click any of the black squares surrounding the graphic.

Note
To resize the graphic proportionally, click any one of the corner 
squares.

3 Without releasing the mouse button, drag the square.

4 Release the mouse button.

5 Click outside of the graphic.
� � � � � � � � � � � � 
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To rotate a graphic

1 Click the graphic.

2 On the �
	� toolbar, click the ���	��  tool.

The pointer changes to four arrows in a circle and four green 
circles appear on each corner of the graphic.

3 Click one of the green circles.

4 Without releasing the left mouse button, rotate the graphic to t
desired position.

5 Release the left mouse button, and then click the �������! 
button.

To reshape a graphic

1 Select the graphic.

2 On the �
	� toolbar, click the ����	��  tool.

The pointer changes to a white arrow. When you move the 
pointer over a reshape point (white circle), it changes to a blac
arrow.

3 Click one of the white circles.

4 Without releasing the left mouse button, drag the reshape poin
a new position.
� � � � � � � � � � � � 
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5 Release the left mouse button, and then click the �������! button 
on the ����	�� toolbar.

Note
When you click the Reshape tool, the Reshape toolbar opens. 
You can use the tools on the Reshape toolbar to edit the curve of 
the shape, add reshape points to the shape, or remove reshape 
points from the shape.

To convert a graphic to a shape

1 Click the graphic.

2 On the *

	�'� menu, point to ���)�
����, and click ��	��.

Note
You can also convert a shape to a graphic. When you convert a 
shape to a graphic, any data attached to the shape, such as field 
codes, VBA, or other shape properties, is lost.

Drawing Callout Lines

Graphics used as notes or descriptions help highlight important 
information about shapes in a diagram. You can attach graphics a
notes to shapes using callout lines. You can also attach graphics 
connector lines or other graphics. After you attach a graphic to a sh
using a callout line, its position is relative to the shape. If you 
reposition the shape in the diagram, the graphic moves with it.
� � � � � � � � � � � � 
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To connect a callout line to a shape from a graphic

1 Click the graphic.

2 Move the pointer over the red square in the graphic

The pointer changes to a white arrow.

3 Click the red square.

4 Without releasing the left mouse button, drag the line from the
red box to the shape.

5 Release the left mouse button.

A red box appears on the shape where the callout line is 
connected.

6 Click outside of the shape.

To format a callout line

1 Click the graphic with a callout line attached to it.

2 On the ��
�	� menu, click �	����� ����.

3 In the ��
�	���	���������� dialog box, select formatting 
options in the ���� tab.

4 To add an arrow to the line and change arrow formatting, click
the *

�� tab.
� � � � � � � � � � � � 
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5 Click 
�.

Tip
If you want to view lines connecting graphics to shapes, click the 
Hidden Lines command on the View menu.
� � � � � � � � � � � � 
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Organizing Diagrams

Working with Diagram Types and Components

Creating multiple components and saving them in a document is a
good way to organize, package, and store similar information. You
create three separate component types using FlowCharter 2000 
Professional:

• Diagrams- Basic Diagrams contain shapes, lines, graphics, an
text describing ideas or functions. Process Diagrams contain 
shapes, connector lines, departments, other graphics and text
process diagrams you can add modeling data that can be use
with iGrafx Process 2000 when simulating a process.

• Scenario- Contains set up information for simulating a process
using iGrafx Process 2000.

• Report- Contains the results of simulating a process using iGra
Process 2000.

Note
Scenario and Report components are used with iGrafx Process 2000.
you used iGrafx Process 2000 to run a simulation, you can select and
view scenario and report data in FlowCharter 2000 Professional.

For any diagram, you can create or add, view, delete, rename or c
paste components. You can also add a component using a saved
template.
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To create a new component

1 On the ���� menu, click ����������.

2 In the ���������� dialog box, click ���, and click &
� ���, 
(	��  ��	'
	�, � ��	
��, or ����
�.

Note
You can only create a scenario or report if you have one process in 
your document.

3 Click �����.

To create a new component from a template

1 On the ���� menu, click ����������.

2 In the ���������� dialog box, click ���, and click ����

�
��������	��.

3 In the ���������������
��������	�� dialog box, browse 
for the template you want to use.

4 In the �����	������������ box, click the component.

5 If necessary, type a new name in the �	�� box, and then click 

�.

6 In the ���������� dialog box, click �����.
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To view a component

1 On the ���� menu, click ����������.

2 In the ���������� dialog box, click *�������������, 
��	'
	��6��
	
 �+, or ��	'
	����+�����	���!�

���	
������.

3 In the tree hierarchy, click the “8” symbol to expand the 
components.

4 Click the component you want to view.

5 Click ����.

6 Click �����.

Tip
All Components lists diagrams, reports, and scenarios. Diagram 
hierarchy lists only diagrams. Diagrams by Contained Departments 
lists diagrams within departments.

To delete a component

1 On the ���� menu, click ����������.

2 In the ���������� dialog box, click *�������������, 
��	'
	� 6��
	
 �+, or ��	'
	����+�����	���!�

���	
������.

3 If necessary, click the “+” symbol to expand the components.

4 Click the component you want to delete.
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5 Click ������.

6 Click �����.

To rename a component

1 On the ���� menu, click ����������.

2 In the ���������� dialog box, click *�������������, 
��	'
	� 6��
	
 �+, or ��	'
	����+�����	���!�

���	
������.

3 If necessary, click the “+” symbol to expand the components.

4 Click the component you want to rename.

5 Click ���	��.

6 Type the new name over the existing name.

7 Click outside of the text box.

8 Click �����.

To copy and paste a component from one document to another 

1 On the ���� menu, click ����������.

2 In the ���������� dialog box, click *�������������, 
��	'
	� 6��
	
 �+, or���	'
	����+�����	���!�

���	
������.

3 In the tree hierarchy, click the “+” symbol to expand the 
components.
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4 Click the component you want to copy, and then click ���+.

Note
You can select multiple components for copying by pressing 
SHIFT and clicking the components.

5 Click �����.

6 On the ���� menu, click 
���, navigate to another document, 
and then click 
�.

7 On the ���� menu, click ����������.

8 In the ���������� dialog box, click &	���. 

The original copied components now appear in the dialog box

9 Click �����.

To convert a basic diagram to a process

With a basic diagram open, point to ��	�'����	'
	���+�� on the 
����� menu, and click &
� ���. 

Note
If you convert a process to a basic diagram, you will lose modeling 
data.
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Working with Layers

With FlowCharter 2000 Professional, you can organize your diagra
in layers. You can place some objects on one layer and others on
another layer such as layering several overhead transparencies.

Layers help you do the following:

• Manage complex diagrams with many overlapping objects.
• Categorize objects that logically belong together by layer.
• View certain objects in your drawing while hiding others.
• Easily select and change objects.
• Protect objects from accidental changes.
• Trace from a template on another layer.
• Print certain objects only.

By default, each diagram has one layer. The default name of each
layer is Layer1, Layer2, and so forth. Layer1 is the back layer.

The Layers command on the Arrange menu contains the following
commands:

• �	+�
��	�	'�
- Opens the Layer Manager that lists the layers
defined for the active diagram and lets you perform layer 
operations. In Layer Manager, you can change the visible, prin
and lock properties of layers. It also lets you select the current
layer; add, delete, and rename layers; change the order of lay
and specify whether you want to change the current or all laye
! � � � � � " � � � � � � � � � � � �  199



Previous Page Next Page
iGrafx
S Y S T E M Home Index

 
ed. 
er 

 
less 
you 

s a 
es 

 
 is 
once, 
• 4!���*����	+�
�- Selects, moves, and changes all objects in the
active diagram, regardless of the layer on which they are locat
When changing all layers, you cannot move an object on a low
layer in front of an object on a higher layer.

• *!!��	+�
: Adds a layer to the active diagram.
• ��)������	+�
- Moves the selected objects to another layer.
• ��)��(	 0�
����	+�
- Moves the layer back one layer.
• ��)����
�	
!�
����	+�
- Moves the active layer forward one 

layer.

The �	+�
� command also lets you switch between changing the 
current layer and changing all layers. Changing all layers lets you
select, move, and change all objects in the active diagram, regard
of the layer on which they are located. When changing all layers, 
cannot move an object on a lower layer in front of an object on a 
higher layer.

At the bottom of each diagram window is a layer tab bar that show
tab for each layer defined for that diagram. The tabs show the nam
of the layers and the order for the layers. A white tab indicates the
current layer. When you hide or lock a layer, the name on that tab
gray. When the tab bar contains more tabs than can be shown at 
scroll arrows appear at the left of the layer tab bar.

Note
If you add markups to a diagram using iGrafx Viewer, a markup tab 
appears next to other layer tabs in FlowCharter 2000 Professional.
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To change the current layer

On the layer tab bar at the bottom of the diagram window, click the
of the layer you want to make the current layer. You may need to sc
the layer tab bar to locate the tab.

Note
When a layer is hidden or locked, the name of the layer on the tab is 
unavailable. You cannot make a hidden or locked layer the current 
layer.

To add a layer to the active diagram

On the *

	�'� menu, point to �	+�
�, and click *!!��	+�
.

The new layer is added in front of the current layer and becomes 
new current layer.

Tips
To display a shortcut menu that lets you add a layer, click a layer tab 
with the right mouse button.
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To change all layers

On the *

	�'� menu, point to �	+�
�, and click 4!���*����	+�
�.

4!���*����	+�
s lets you select, move, and change all objects in th
active diagram, regardless of the layer on which they are located.
When changing all layers, you cannot move an object on a lower la
in front of an object on a higher layer.

Notes
New objects are always placed on the current layer, even when you a
changing all layers.

To switch back to changing just the current layer, clear Edit All 
Layers.

To display a shortcut menu that lets you edit all layers, use the right 
mouse button and click a layer tab.

To delete a layer

1 On the *

	�'� menu, point to �	+�
�, and click �	+�
�
�	�	'�
.

2 Click the name of the layer you want to delete.
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3 Click ������.

Notes
When you delete a layer, all objects on the layer are deleted.

You also can use the Layer Manager  tool on the Draw toolbar.

To display a shortcut menu that lets you delete a layer, use the right 
mouse button and click the layer tab for the layer you want to delete.

To rename a layer

1 On the *

	�'� menu, point to �	+�
�, and click �	+�
�
�	�	'�
.

2 Click the name of the layer you want to rename.

3 Click ���	��.

4 Type the new name.

5 Click 
�.

6 Click 
�.

Tips
You also can use the Layer Manager  tool on the Draw toolbar.

To display a shortcut menu that lets you rename a layer, use the righ
mouse button and click the layer tab for the layer you want to rename
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To change the order of a layer

1 On the *

	�'� menu, point to �	+�
�, and click �	+�
�
�	�	'�
.

2 Click the name of the layer you want to reorder.

3 Click ��)��9� or ��)������ as necessary to position the 
layer in the list where you want it.

4 Click 
�.

Tip
To display a shortcut menu that lets you change the order of the layer
use the right mouse button and click the layer tab for the layer you 
want to change the order of.

To move an object to a different layer

1 Click the object.

2 On the *

	�'� menu, point to �	+�
�, and click ��)�����

�	+�
.

3 Click the layer to which you want to move the object.
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4 Click 
�.

Tips
When you move objects to another layer, you can make that layer the
current layer.

To display a shortcut menu that lets you move a selected object to 
another layer, use the right mouse button and click the layer tab for th
layer you want to move.

To move an object back one layer

1 Click the object.

2 On the *

	�'� menu, point to �	+�
�, and click ��)��(	 0�


����	+�
.

Tips
You can also press CTRL+F9 to move the selected object back one 
layer.
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To move an object forward one layer

1 Click the object.

2 On the *

	�'� menu, point to �	+�
�, and click ��)� 
��
�	
!�
����	+�
.

Tips
You can also press CRTL+F10 to move the selected object forward 
one layer,

To show or hide a layer

1 On the *

	�'� menu, point to �	+�
�, and click �	+�
 
�	�	'�
.

2 To hide a layer, clear the box under the bulb icon for the layer. 
show a layer, select the box under the bulb icon for the layer.
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3 Click 
�.

Notes
You cannot hide the current layer. If you try to hide the current layer, 
the Layer Manager does not close until you make the layer visible or 
change the current layer to a visible layer.

To speed up the redraw of complicated drawings, hide the layers that
you are not currently working with.

To display a shortcut menu that lets you show or hide a layer, use the
right mouse button and click the layer tab for the layer you want to 
show or hide, and then click Visible.

Hiding a layer does not affect its print property.
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To make a layer printable or nonprintable

1 On the *

	�'� menu, point to �	+�
�, and click �	+�
 
�	�	'�
.

To make a layer nonprintable, clear the box under the printer ic
for the layer.

To make a layer printable, select the box under the printer icon
for the layer.

2 Click 
�.

Notes
You can print hidden layers unless they are also nonprintable.

To display a shortcut menu that lets you show or hide a layer, use the
right mouse button and click the layer tab for the layer you want to 
make printable or nonprintable.

You also can use the Layer Manager tool  on the Draw toolbar.

To lock or unlock a layer

1 On the *

	�'� menu, point to �	+�
�, and click �	+�
 
�	�	'�
.

2 To lock a layer, select the box under the lock icon for the layer

3 To unlock a layer, clear the box under the lock icon for the laye

4 Click 
�.
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When a layer is locked, it can be displayed or hidden, but it 
cannot be changed, reordered, or deleted.

Note
You cannot lock the current layer. If you try to lock the current layer, 
the Layer Manager does not close until you unlock
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Linking Diagrams

Linking and Embedding from Other Applications

OLE is a protocol that is used by many Windows applications to 
exchange information. FlowCharter 2000 Professional acts as an 
container application. You use OLE to include information from oth
programs into your diagrams.

When you include OLE information, you choose whether to embed
link it. The main difference between linking and embedding is whe
the data is stored.

Embedding Objects

The advantage to embedding is that one diagram contains all the 
information. If you copy the file to a floppy disk or another comput
system, all of the objects are stored within it. The disadvantage is
size and performance are affected as the number of embedded ob
increases.

Linking Objects

The advantage to linking is that you ensure that the most recent 
information prepared by other users or computer systems can be 
up-to-date in your file. The disadvantage is that the linked objects
could be moved or become unavailable.
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Note
You can create an OLE link to any Windows application that acts as a
OLE server. To link to other iGrafx documents, use the Link command
on the Insert menu.

Inserting an Embedded Object

When you create a new object, it is automatically an embedded ob
because there is no file to link it to. An embedded object becomes
of the FlowCharter 2000 Professional diagram.

When you embed an object, you can specify either that its conten
appear in the diagram or that an icon be displayed. For example, 
can put the contents of a Microsoft Excel chart in the diagram, or 
can display the Excel icon.

Insert Object dialog box

Element Description

Create New Invokes an application and creates a new 
occurrence of one of its objects. For example, 
you can open a package like Microsoft Equation
design a formula, and insert it beneath a symbo
in the diagram. 
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Object Type Displays a list of all applications registered on
your computer as OLE objects. The list varies 
from installation to installation, depending on 
the software that is available.

Create from File Inserts an object that already exists. This optio
changes the dialog box. Type the full path nam
for the object or use the Browse button to locat
the file. If you choose Link, the object is linked;
otherwise, the object is embedded.

Display as Icon Represents the object in the diagram as an ic
This option changes the dialog box so that it 
displays the current icon. You can change it by 
clicking on the Change Icon button. 
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Convert To dialog box

Element Description

Convert To Permanently converts the object to the new 
object type, and displays a list of valid types for
your computer system. For example, if the objec
is a graphic, then the list includes the graphic 
editors that recognize the current type (and 
therefore can be used to edit it).

Activate As Temporarily activates all embedded objects of 
the selected type. For example, converts all 
PowerPoint drawings to a different graphic 
editor. When you edit the object, you use the 
application you choose, but changes are saved
the PowerPoint format. This option is available 
only if there are two or more embedded objects
of the same type.

Display as Icon Displays the object as an icon. You may want
change the icon at this point to correlate to the 
new format.
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To insert a new embedded object

1 On the 7���
� menu, click 
�4�
�;� �.

Note
The registration database is the source of information used by 
applications that support OLE. This is the database used by 
FlowCharter 2000 Professional to determine which objects are 
registered on your computer for OLE purposes.

The database (called reg.data) is set up and maintained by Windows
and Windows applications and is located in the Windows directory. If 
FlowCharter 2000 Professional does not recognize an application 
object, it may be due to a problem in this database. Do not move or 
delete this file, since doing so may result in a loss of functionality in 
applications that support OLE.

2 In the 7���
��
�;� � dialog box, select the object type, and then
click 
�.

3 When you finish creating or editing the object that you want, 
close the application.

Note
Some applications ask you to confirm that you want to close and 
update the diagram; others do not. If you are satisfied with the object,
be sure to choose Yes or OK to update the diagram.
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To edit an embedded object

1 Select the OLE object in the diagram.

2 On the 4!�� menu, point to B�+��C�
�;� �, and click 4!��.

(The [Type] of object may appear in the menu. For example, th
menu item for a document might be Document Object.)

This opens the application that created the object. For example
you have embedded a CorelDraw drawing, you can open 
CorelDraw and edit the drawing by double-clicking it in the 
FlowCharter 2000 Professional diagram.

To convert an embedded object to a different format

1 Select the OLE object in the diagram.

2 On the 4!�� menu, point to B�+��C�
�;� �, and click ���)�
�.

The current type of object is listed at the top of the ���)�
� 
dialog box.

3 In the ���)�
� dialog box, select a new object type from the list
and click 
�.
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Dragging and Dropping

If you have a source application that supports drag and drop and O
you can create an embedded object by copying from a source file
pasting into a diagram. You can either drag and drop a selected ar
use the Paste Special menu.

Links dialog box

Element Description

Update Now This updates the linked object. If the source ha
changed since you opened the diagram or last 
updated the link, this option loads the new 
version.

Open Source This opens the source file in its source 
application. 

Change Source This opens the Change Source dialog box so
can change the source file. You can choose a 
different file by entering a new path or using the
Network button to set the location.

Break Link This breaks the link and disconnects from the 
application. When you break a link, the linked 
information remains in your diagram. However,
it can no longer be updated. The link becomes 
standard graphic. Once you break a link, you 
cannot reconnect it. 
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To embed an object into a diagram

1 Open both the source file and the FlowCharter 2000 Professio
diagram, and adjust the window sizes so that both applications
are fully displayed on the screen.

2 Select the area in the source file that you want to link.

3 Drag the area into the diagram.

To move the area, use the mouse to drag the area into the 
diagram. The cursor indicates that the selected area is being 
moved.

To copy the area, press and hold the ���� key while you use the 
mouse. The cursor changes to indicate that a copy is made of
selected area.

4 Release the mouse button.

Note
If you drop an area directly over an activity symbol, the area is 
embedded in the symbol.

+
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To use Paste Special for OLE objects

1 Make sure that you save the source file before you link the 
information.

2 Open the source file and select the information that you want t
link.

3 On the 4!�� menu. click ���+.

4 Switch to FlowCharter 2000 Professional, and click &	����

��� �	� on the 4!�� menu.

5 In the�&	������� �	� dialog box, select &	����or &	�������0.

Paste- Embeds the object. 

Paste Link- Links the object.

6 Select the Format in the *� box.

7 To display the link as an icon, select �����	+�	��7 ��.

8 Click 
�.

To create a link to an object

1 On the 7���
� menu, click 
�4�
�;� �.

2 In the 7���
��
�;� t dialog box, select �
�	���#
�������.

3 Type the path to the object or use the (
���� button to locate it.

4 Select the ���0 box.
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5 If you want to display the contents of the object as an icon, sele
�����	+�	��7 ��.

Note
If you do not display as an icon, then the contents of the object 
are shown. For example, the first page of a Word document is 
displayed.

To edit linked information

Click the shape, and click 
�4����0� on the 4!�������.

The ���0� dialog box opens, and each link is displayed with its pat
type, and update method.

To control how links are updated

1 On the�4!�� menu, click 
�4����0�.

2 Select the link that you want to update.

Note
You can select multiple links by holding down the CTRL key 
while you click each link.

3 For Update, select one of the following:

Automatic- Updates linked information every time there is a 
change in the source file.
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Manual- Updates linked information only when you save the 
source file yourself.

To view as an icon

1 Click a linked object.

2 On the 4!�� menu, point to B�+��C�
�;� �, and click ���)�
�.

3 In the ���)�
� dialog box, select the �����	+�	��7 �� box.

4 To change the type of icon displayed, click ��	�'��7 ��.

5 Click 
�.

Linking Shapes to Other Diagrams or Web Pages

You can link shapes to other diagrams or Web pages using 
FlowCharter 2000 Professional. Linking lets you disclose informat
in levels by linking shapes in one diagram to a group of related 
diagrams.

Linking Shapes to Other Diagrams

Linking shapes to other diagrams helps people in organizations o
sizes deliver several diagrams from one source. For example, a 
diagram containing marketing goals can have linked shapes to mo
in-depth diagrams explaining sales divisions and the goals of each
person within the division.

Use the General and Inputs tabs on the Properties dialog box to:
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• Add links to a new diagram
• Add descriptions and key modifiers to linked shapes
• Edit and delete existing links
• Add advanced link settings
• Activate links

Linking Shapes to Web Pages

Linking shapes to Web pages is another way to distribute diagram
a larger audience. A sales manager using the example above cou
take the same diagram source and post it to the company Intrane
page. Travelling sales people can then browse the company Intran
get the latest information on goals and what other sales divisions 
doing.

To link a shape to a new diagram

1 In the active diagram, click ���������� on the ���� menu.

2 In the ���������� dialog box, click ���, and then click (	�� �
��	'
	� or &
� ���.

A new (	�� ���	'
	� or &
� ��� is created.

3 Click �����.

4 On the ���!��� menu, click the name of your initial diagram.

5 Right-click the shape that you want to link the new diagram to,
and then click &
���
����.
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6 In the &
���
���� dialog box, click the "���
	� tab, and then 
click ���.

7 In the *!!����0 dialog box, select the new diagram from the 
�	�� box.

8 To add a key modifier, click the ��+���!�#��
� box, and then 
press ����, *��, �67��, or any combination of the three.

Key modifiers let you modify the linked shape without activating
the link. For example, if you select ���� as a key modifier you 
can do two things:

Double-click the shape- This opens the &
���
�����dialog box so 
you can edit the link.

Press �����and double-click the shape- This activates the link.

Note
If you are using hotkeys to move around in the Add Link Dialog box, 
ALT will replace any key modifiers you have set.

9 To add a description for the link, type a description in the 
��� 
������ box.

10 Click 
�.

11 In the &
���
���� dialog box, click 
�.
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To edit a linked shape

1 Right-click the linked shape, and then click &
���
����.

2 In the &
���
���� dialog box, select the link in the ���0� box.

3 Click 4!��.

4 In the ��	�'�����0 dialog box, make any changes.

5 Click 
�.

6 In the &
���
���� dialog box, click 
�.

To activate a linked shape

Double-click or use the assigned key modifier on a shape.

or

Right-click the linked shape, and then click the named link at the 
bottom of the menu.

or

Right-click the linked shape. In the &
���
���� dialog box, click the 
"���
	� tab, select the link in the ���0� box, and then click * ��)	��.

To delete a linked shape

1 Right-click the linked shape, and then click &
���
����.

2 In the�&
���
���� dialog box, select the link in the ���0� box.

3 Click ������.
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4 Click A4�.

5 In the &
���
���� dialog box, click 
�.

To add advanced link settings

1 Open a diagram containing the link you want to use.

2 Open the diagram that you want to link to.

3 Right-click the shape that you want to be the starting point of th
diagram, and then click &
���
����.

4 In the &
���
���� dialog box, click the 7����� tab.

5 Select the ��	
��&���� box, and click 
�.

6 Open the diagram that contains the shape you want to link.

7 Right-mouse click the shape, and then click &
���
����.

8 Click the "���
	� tab, and then select the link in the ���0��box.

9 Click 4!��.

10 In the ��	�'�����0 dialog box, click *!)	� �!.

11 In the *!)	� �!����0�������'s dialog box, select ��	
��#
���

������	
��&��������.

12 To accumulate custom data attached to the shape, select 
*  ����	�����������	�	.

13 Click 
�.

14 In the ��	�'�����0 dialog box, click 
�.

15 In the &
���
���� dialog box, click 
�.
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To link a shape to a file or Web page

1 Click the shape that you want to link.

2 On the 7���
� menu, click����0.

3 In the *!!����0 dialog box, select ���� or ����&	'�.

4 To link a shape to a file, type the path in the &	�� or 9�� box.

5 To link a shape to a URL, type the relative path in the &	�� or 
9�� box.

6 To add a key modifier, select the ��+���!�#��
� box, and then 
press ����, *��, �67��, or any combination of the three.

Key modifiers let you modify the linked shape without activating
the link. For example, if you select ���� as a key modifier you 
can do two things:

Double-click the shape- This opens the Properties dialog box 
you can edit the link.

Press ���� and double-click the shape- This activates the link.

Note
If you are using hotkeys to move around in the Add Link Dialog box, 
ALT will replace any key modifiers you have set.

7 To add a description for the link, type a description in the 
��� 
������ box.

8 Click 
�.
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Using Advanced Diagramming Features

Working with Custom Data

FlowCharter 2000 Professional lets you add custom data fields to
individual shapes in a diagram. Each data field for a shape has its
name and function. For example, you can accumulate data using 
selections in the Setup Custom Data dialog box for a shape labele
Test. You can use this feature to analyze the cost of activities along
critical path of a process:

Field Elements

Cost Name - Type Cost.

Type - Select Currency.

Format - Select $###0.00.

Accumulation Method - Select Sum.

Duration Name - Type Duration.

Type - Select Duration.

Format - Select #hrs.

Accumulation Method - Select Sum.
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After applying these selections, type the dollar amount for Cost an
the time for Duration in the Custom Data tab on the Properties dia
box. If you have fields set up to display at the bottom of the shape,
is what the shape looks like in the diagram:

Note
Any information that you change in these fields at a later time will 
automatically update in the diagram.

To add custom data fields to a shape

1 Right-mouse click the shape that you want to add fields to.

2 Click &
���
����.

3 In the ��������	�	��	�, click �����.

4 In the ��������������	�	 dialog box, type a name for the field 
in the �	�� box.

5 Select a type, format, and accumulation method for the field in
each of these lists.

To add more fields, clear the �	�� box and repeat steps four and
five.
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6 Click 
�.

7 In the ��������	�	 tab, click the field next to the name, and 
then type the field information.

For example, if you have a field labeled Cost, type 15.00.

8 Click 
�.

Note
You can display fields in or around the shape.

To delete custom data fields from a shape

1 Right-mouse click the shape that you want to delete a field fro

2 Click &
���
����.

3 In the ��������	�	��	�, click �����.

4 In the ��������������	�	 dialog box, click the field in the 
��������	�	 box, and then click ������.

5 Click 
�.

6 In the &
���
���� dialog box, click 
�.

To add advanced custom data field options to a shape

1 Right-mouse click a shape containing field(s).

2 Click &
���
����.

3 In the ��������	�	 tab, click �����.
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4 In the ��������������	�	 dialog box, click 
������.

5 Edit hours per day and days per week, and then click 
�.

6 In the ��������������	�	�dialog box, click 
�.

7 In the &
���
���� dialog box, click 
�.

To insert a legend displaying custom data

On the ����� menu, point to ��������	�	, and click 7���
��
��'��!.

The Legend displays custom data added to shapes.

Working with Visual Basic for Applications

FlowCharter 2000 Professional contains Microsoft’s Visual Basic f
Applications (VBA), version 6.0 as its integrated development 
environment. VBA provides a programming interface to the power
features that comprise FlowCharter 2000 Professional. Used with
iGrafx System, you get a powerful graphics engine and a developm
environment that lets you quickly extend the capabilities of 
applications. For more information on iGrafx System, see Developing 
Custom Solutions with iGrafx System included in your box.
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VBA is a widely used programming language and is integrated int
Microsoft’s Office products. If you have any experience customizin
or extending these applications, then you have a head start in 
developing with iGrafx System. Even without prior experience, you
have the advantage of using a widely accepted and standardized 
development tool.

To run a VBA macro

1 On the ����� menu, point to ����	��(	�� , and click �	 
��.

2 In the �	 
�� dialog box, select a macro from the list.

3 Click ���.

Note
This procedure assumes that you opened a document containing 
VBA macros. If no macros exist in the document you are 
creating or opening, the Macros command on the Tools menu 
will not be active.

To open a VBA Extension Project

1 On the ����� menu, point to ����	��(	�� , and click 4���������
&
�;� ��.

2 Click 
���.

3 Navigate to a iGrafx Extension Project (*.flx), and click 
���.

The project is added to list in the 4���������&
�;� � dialog box.
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4 Select the box next to the project, and click 
���.

To modify VBA security settings

1 On the ����� menu, point to ����	��(	�� , and click �� �
��+.

2 In the �� �
��+ dialog box, select:

High- Prevents any unsigned macros from automatically runnin

Medium- Lets you choose whether or not to run macros. This 
the recommended setting.

Low- Lets all macros run. This is not a recommended setting.

3 Click 
�.

Working with iDiagrams

An iDiagram is a diagram that runs like a program. iDiagrams wal
you through shapes containing VBA code, letting you make the 
decisions as you go. These decisions move you along a path from
shape to shape where custom data is collected.

After you place shapes in an iDiagram, you can add code to them
using Visual Basic. Using the iDiagram Entity Manager, you can s
though, stop, and pause an iDiagram. You can also add or delete 
entities from shapes using the Manager.

For more information about developing custom code for use with 
shapes, view the help file provided with Visual Basic.
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To create a new entity

1 On the ����� menu, point to ���	'
	�, and click 4����+�
�	�	'�
.

2 Click the *!!�4����+  tool.

To add an entity to a shape

1 On the������ menu, point to ���	'
	�, and click 4����+�
�	�	'�
.

2 Select an existing entity, or create a new entity.

3 Click the shape that you want to add the entity to.

To delete an entity from a shape

1 On the ����� menu, point to ���	'
	�, and click 4����+�
�	�	'�
.

2 Select an entity.

3 Press �4�4�4.

To run an iDiagram

On the ����� menu, point to ���	'
	�, and click 4�� ���.
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Working with SPC Charts

FlowCharter 2000 Professional lets you create different kinds of ch
that support quality and process re-engineering. To implement the
processes, quality charts are needed for relaying complex data in
to understand formats.

With SPC charts, you can:

• Identify unstable processes
• Visualize extent of variation in a process
• Improve decision-making
• Identify special cause variation in a process
• Predict progress of a process
• Determine current ability of a process
• Analyze processes over time
• Compare data
• Organize data into recognizable categories
• Set priorities of a process
• Illustrate impacts of individual affects
• Show relationship between paired data

To select and place SPC charts in a diagram, use the DataAnalyz
Chart wizard. After selecting which chart you want to use, you can
type information into an active spreadsheet in the diagram space.
DataAnalyzer then graphically converts the data for display in the 
diagram.
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For more information on specific SPC chart types, select a chart in
DataAnalyzer Chart wizard, and click More. To get information on
DataAnalyzer functions, view datalyzer.hlp located in iGrafx\Pro\8

You can create the following charts using FlowCharter 2000 
Professional and DataAnalyzer:

• Process charts
• Cause-and-effect (Ishikawa or fishbone) charts
• Organization charts
• Deployment charts
• Pareto charts
• Histograms
• Run charts (trend charts)
• Control charts
• Scatter charts
• Pie charts

To insert a SPC chart in a diagram

1 On the 7���
� menu, click �&����	
�.

2 In the �	�	*�	�+��
���	
� wizard, click ����.

3 Select a chart type, and click ������.
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To add data to a SPC chart

1 Insert an SPC chart in the diagram.

2 In the active spreadsheet, type x and y axis labels in the cells.

3 Click the �	�	�7���
�����	
!  tool.

4 Follow the steps in the Data Import wizard.

5 After you have imported the data, click outside of the SPC cha

The SPC chart is inserted in the diagram.

To delete a SPC chart from a diagram

1 Click the ���� ��
  tool on the ������� toolbar.

2 Click the SPC chart.

3 Press �4�4�4.

Working with iGrids

iGrids are graphical templates that you can use to diagram hierarc
matrices, comparisons, schedules, timelines, and checklists. Each
iGrid has corresponding options for adding or removing elements,
sizing, placing, and aligning. After choosing from these options, th
iGrid appears in the diagram space.

Depending on which iGrid you select, a Share Media subject tab w
appear in the Gallery. Use the clip art in these tabs to add graphics
color to your iDiagrams
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The following chart describes the iGrid templates in FlowCharter 
2000 Professional:

iGrid Description

Pyramid Shows hierarchical lists, such as those illustratin
business values and goals or customer 
requirements.

Basic Shows a grid of squares in the diagram. The grid
enables you to place objects in precise positions.

Block Shows a graphical matrix or gives a brief overview
of a process.

Cascade Shows items in a sequence, such as steps in a 
process.

Process Shows the details of a process so that it can be 
readily understood.

Deployment Shows the flow of information and materials 
among different organizational units.

Comparison Shows comparisons of items in columns and row
such as products and features.  These charts can
represent yes/no relationships (using check mark
or thumbs up/down) or multiple-value 
relationships (using filled bullets). 

Timeline Shows schedules for tasks, projects, and 
procedures.
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To insert an iGrid

1 On the 7���
��menu, click �"
�!.

2 In the�7���
���"
�!�dialog box, click the iGrid icon that you want 
to insert.

3 Edit the options you want to change.

4 Click 
�.

To edit an iGrid in the diagram space

1 Right-mouse click the iGrid.

2 Click 4!����"
�!.

Circle-Spoke Shows items in a circular arrangement, connect
to a center shape.  Spoke charts are useful for 
illustrating business principles, the key benefits o
a product, or a product line.

Target Shows concentric rings of focus, such as with 
increasingly focused customer groups and busine
objectives.

DrawBar Shows general relationship and conceptual 
quantitative relationships (for example, something
is smaller than or larger than something else).

Checklist Shows single or multiple-column visual checklist
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Yellow sizing diamonds appear on edges of the iGrid in the 
diagram.

3 To change the size of the iGrid, click the diamonds and drag th
iGrid to a new position.

4 To finish the positioning, click the ���� ��
  tool, and then 

click outside the diagram space.
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3D effects, adding to shapes� ���

A

Actions, undoing� ��

Adding
fields to shapes� ���

preset line styles� �	


preset shape styles� �	�

preset text styles� ���

shadow or 3D effects to shapes� ���

shape fill color, pattern, or gradient� ���

shapes to the Shape Library� ���

shapes to Toolbox toolbar� ���

verticies to lines� ���

Advanced shape field options� ���

Aligning
objects� ��������

text blocks� ���

Angles, rotating� ���

Applying
arrow and crossover formats� ���

fill formats� ���

line and border formats to shapes� ���
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Arrange menu� ��

Arranging, shapes in the Shape Library� ���

Arrowheads, choosing� ���

Arrows, applying formats� ���

Attaching, text to lines� ���

Automatic
renumbering of all shapes� ���

renumbering of shapes� ���

Automatic Recovery
saving� ������

B

Borders
adding to department lanes� ���

applying formats� ���

formatting lines for shapes� ���

Bringing, objects to the front� ���

Bullet styles, setting for text� ���

Business diagrams, editing� ��
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Callout Lines
connecting to a shape from a graphic� �
�

formatting� �
�

Cascading, windows� ��

Chalk talks� ��

Changing
number format for existing shapes� ��


shadow depths� ��


shadow directions
shadow styles� ���

Checking, spelling� ��

Choosing
arrowheads� ���

indicators for shapes� ��

line crossovers� ���

line routing types� ���

preset line styles� �	


preset shape styles� �	�

preset text styles� ���

spelling options� ��

text styles� ���

Clearing, objects� �	

Clipboard� ��

Closed objects, connecting� ���

Closing, documents� ��

Color
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adding to shadows� ��


adding to shape fill� ���

adding to text� ���

Coloring
lines� �	

shapes� �	

text� �	

Components
copying and pasting� �
�

creating new� �
�

deleting� �
�

renaming� �
�

viewing� �
�

Connect points
editing between shapes� ��


moving line ends on a shape� ��


Connecting
closed objects� ���

open objects� ��


shapes by clicking� ���

shapes by dragging� ���

shapes with lines� ���

using the Connect Shapes command� ��


Connectors, choosing for lines� ���

Converting
FlowCharter charts� 	�

graphics to shapes� �
�

Copies, saving for documents� ��
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Copying, objects� ��

Creating
colors� ��

floating palettes� ��

new documents� 	�

new toolbars� ��

templates� 	�

text blocks
shape text� ���

text on lines� ���

Crossovers, applying formats� ���

Cursors, placing in text� ���

Cutting
objects� ��

text in the Note window� ��

D

Data fields
adding� ���

adding advanced options� ���

deleting� ���

Default number, setting format for new shapes� ��


Defaults
Default tab, setting for shapes and lines� �	�

Default tab, setting for text� ���

setting for arrowheads� ���
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setting for diagrams� �	�

setting for text� ���

Shape Library, setting for shapes and lines� ���

Shape Library, setting for text� ���

Share Media, setting for shapes and lines� ���

Share Media, setting for text� ��	

Deleting
departments� ��	

objects� �	

preset line styles� ���

preset shape styles� �	�

preset text styles� ���

shapes from Shape Library� ���

text� ��	

text in the Note window� ��

toolbars� ��

Departments
adding borders and dividers to lanes� ���

adding color, patterns, and gradients to� ���

changing lane margins and minimum lane size� ��	

deleting� ��	

editing text in department headers� ��	

inserting� ���

moving the location of names� ���

reordering� ��	

setting the lane orientation of� ���

setting the text orientation for labels� ���

setting up� ���
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Diagram elements, viewing� ��

Diagram objects
deleting� �


duplicating� �


selecting� �


Diagrams
adding layers� ���

changing all layers� ���

changing current layers� ���

changing the order of layers� ��	

copying and pasting components� �
�

creating new components� �
�

defining page setup� 
�

deleting components� �
�

deleting layers� ���

importing other formats� 	�

locking� ��

making layers printable or nonprintable� ���

moving an object to a different layer� ��	

moving objects back one layer� ���

moving objects forward one layer� ���

opening VBA Extension Projects� ���

placing shapes in� ���

printing� ��

renaming components� �
�

renaming layers� ���

running VBA macros� ���

saving as web pages� ��
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selecting the page orientation for� 
�

setting defaults for� �	�

setting the page margins for� 
�

setting the paper size for� 
�

setting the Print Notes option� 
	

setting the scaling for� 
�

setting titles for� 
�

setting up a diagram page� 
�

setting VBA security levels� ���

showing or hiding layers� ���

unlocking or locking layers� ���

viewing� ������

viewing components� �
�

zooming� ��

Directions, changing for a shadow� ���

Disconnecting, objects� ��


Distributing, documents� �


Docking, toolbars� ��

Documents
creating new

using the Welcome dialog to create� 	�

creating using the New command� 	�

distributing� �


new from a template� 	�

new from the Welcome dialog� 	�

opening� 	�

opening using the Welcome dialog� 	�

saving� ��
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closing� ��

saving copies� ��

sending as e-mail� 
�

unprotecting� ��

locking� ��

using the Open command� 	�

Dragging and Dropping, OLE objects� ���

Draw toolbar� 


Drawing, graphics� ���

Duplicating
diagram objects� �


objects� �	

shapes in Shape Library� ���

E

Edit menu� ��

Editing
business diagrams

process maps� ��

connect points between shapes� ��


department headers� ��	

shapes in Shape Library� ���

E-mail, sending documents as� 
�

Encryption� ������

Ends, line� ���
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F

Field descriptions, including with shapes� ��	

Fields
adding to shapes� ���

moving in or around shapes� ��	

File menu� ��

Fills, applying formats� ���

Finding
text� ��

Finding, text� �


Fitting, shapes to text� �	�

Flipping, objects� ��������

Floating palettes, creating� ��

FlowCharter 7.0
opening diagrams in� ��

opening files� 	�

FlowCharter formats, saving older documents from� ��

Fonts, setting text defaults� ���

Footers
creating custom� 
�

inserting� 
�

using� 
�

Format menu� ��

Formatting
applying fills� ���

callout lines� �
�

lines� ���
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lines for shape borders� ���

shapes and lines, described� ���

text� ��	

Formatting toolbar� �

Full screen views� ��

G

Gallery� �


Gallery, placing shapes using� ���

Gradient, adding to shape fill� ���

Graphics
adding text� ���

connecting callout lines to shapes� �
�

converting to shapes� �
�

drawing� ���

formatting callout lines� �
�

moving� ��


reshaping� �
�

resizing� ��


rotating� �
�

Grids
showing dots� 



snapping objects to� ���

turning on for snapping� 



using� 
�

Grouping, objects� ���
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Guidelines
adding horizontal� 
�

adding vertical� 
�

deleting� 



moving� 
�

using� 
�

H

Headers
creating custom� 
�

inserting� 
�

using� 
�

Help menu� 	�

Hidden lines, viewing� ��

Hiding
diagram layers� ���

rulers� ��

shape numbers� ���

toolbars� ��

ToolTips� ��

Horizontal alignment, setting for text� ���

Horizontal lines� �	�

Horizontally, tiling windows� ��

HTML, saving diagrams as� ��
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I

iDiagram toolbar� ��

iDiagrams
adding entities to shapes� ���

creating entities� ���

deleting entities from shapes� ���

running� ���

iGrafx Professional tools, using� �


iGrafx Share Media
using� ��

iGrafx Share Viewer, using� �


iGrids
editing� ���

inserting� ���

Indicators� ������

Insert menu� ��

Inserting, departments� ���

Intersecting, objects� �	�

J

Java, saving diagrams as applets� ��

Joining
objects� �	�
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K

keyboard selection, moving text� ���

L

Lane margins, changing size� ��	

Lane orientation, setting for departments� ���

Layers
adding to diagrams� ���

changing all in a diagram� ���

changing current� ���

changing the order of� ��	

deleting� ���

locking or unlocking� ���

making printable or nonprintable� ���

moving an object to a different layer� ��	

moving objects back one layer� ���

moving objects forward one layer� ���

renaming� ���

showing or hiding� ���

Legends, inserting� ��


Line ends
moving from connect points on a shape� ��


reversing between shapes� ���

Line formats, applying� ���
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Line offset� �	�

Line spacing, setting for text� ���

Lines
adding a vertex to� ���

adding preset styles� �	


attaching text to� ���

callouts� �
�

choosing arrowheads� ���

choosing crossovers� ���

choosing off-page connector functions� ���

choosing preset styles� �	


choosing routing types� ���

coloring� �	

connecting shapes with� ���

deleting preset styles� ���

formatting� ���

formatting for shape borders� ���

manipulating with Shapes� ���

renaming preset styles� ���

restoring automatic line moves� ���

selecting� ��

setting spacing� �	�

Linking
controlling OLE objects� ��


OLE objects� ���

Links
activating� ���

adding advanced settings� ��	
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adding to a file or Web page� ���

adding to shapes� ���

deleting� ���

editing� ���

Locking
diagrams� ��

documents� ��

layers� ���

M

Making objects same size� ��������

Manipulating, shapes and lines together� ���

Manual, renumbering of shapes� ���

Master Page, viewing� ��

Model menu� 	�

Modifying, connect points between shapes� ��


Moving
line ends from connect points on a shape� ��


objects back one layer� ���

objects forward one layer� ���

objects to the back� ���

objects to the front� ���

shape fields� ��	
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New command, creating new documents� 		��	�

Nodes, indicators� ��

Normal view, using� ��

Notes� ��

attaching to shapes� �	

in diagrams� ��

printing� ����
	

Numbering
all shapes� ���

renumbering� ���

shapes� ��������

Numbering position, setting for shapes� ���

O

Objects
aligning� ���

bringing to front� ���

connecting closed� ���

connecting open� ��


copying� ��

cutting� �����	

disconnecting� ��


duplicating� �	
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flipping� ���

grouping� ���

intersecting� �	�

joining� �	�

making same size� ���

outlining� �	�

pasting� ��

rotating� ���

angle rotation� ���

selecting� ��

sending to back� ���

slicing� �	�

spacing evenly� ���

ungrouping� ���

Off-page Connectors, choosing for lines� ���

Older documents, saving from FlowCharter� ��

OLE Objects
controlling links� ��


converting embedded� ���

creating links� ���

editing embedded� ���

embedding into diagrams� ���

inserting new� ��	

using the Paste Special command for� ���

viewing as an icon� ���

Open command, using� 	�

Open objects, connecting� ��


Opening
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documents� 	�

documents using the Open command� 	�

documents using the Welcome dialog� 	�

FlowCharter 7.0 diagram� ��

Optima! 2.5 file� ��

Output window� ��

Windows Draw file� ��

Optima! 2.5 file, opening� 	�����

Options, spelling� ��

Ordering� ���

Orientation, setting for text in shape fields� ���

Outlining, objects� �	�

Output window
using� ��

Output window, using� ��

P

Page breaks, viewing� ��

Page margins, setting� 
�

Page Setup
creating custom headers and footers� 
�

defining� 
�

inserting headers and footers� 
�

selecting the page orientation for� 
�

setting diagram titles� 
�

setting page margins� 
�
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setting the diagram scaling for� 
�

setting the page order for printing� 
	

setting the paper size for� 
�

setting the Print Notes option� 
	

setting up a diagram page� 
�

using headers and footers� 
�

Palettes, as floating toolbars� ��

Password protection� ��

Paste Special command
using� ��

using for OLE objects� ���

Pasting, objects and notes� ��

Pattern, adding to shape� ���

Phases� ���

deleting lines� ���

formatting lines� ���

inserting lines� ���

labeling lines� ���

Placing
shapes in diagrams� ���

shapes using the Gallery� ���

shapes using the Shape Library� ��	

Presentations� ��

Preset line styles
adding� �	


choosing� �	


deleting� ���

renaming� ���
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working with� �		

Preset shape styles
adding� �	�

choosing� �	�

deleting� �	�

renaming� �	�

working with� �		

Preset Styles toolbar� �	

Preset text styles
adding� ���

choosing� ���

deleting� ���

renaming� ���

Previewing� �


Printing
diagram layers� ���

diagrams� ��

notes� ����
	

previewing� �


setting the page order for printing� 
	

Process maps, editing� ��

Protecting, diagrams� ��

Protecting, documents� ��

R

Renaming
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preset line styles� ���

preset shape styles� �	�

preset text styles� ���

toolbars� �


Renumbering
all shapes automatically� ���

shapes automatically� ���

shapes manually� ���

Reopening, workspaces� ��

Reordering, departments� ��	

Replacing
shapes� �	�

text� �


text in shapes� ��

Resetting, toolbars� �


Reshaping, graphics� �
�

Reversing
an undo� ��

line ends between shapes� ���

Rotating
graphics� �
�

objects� ���

objects by angles� ���

text in a text block� ��


text with a shape� ��


Rulers, hiding� ��
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S

Save as command, using for documents� ��

Saving
automatic recovery� ������

copies of documents� ��

diagrams as web pages� ��

documents� ������

documents from older FlowCharter formats� ��

workspaces� ������

Searching
text� �


Security� ������

Selecting
angle and direction for rotating an object� ���

diagram objects� �


objects� ��

text� ���

text by dragging� ���

text using the keyboard� ���

Sending
documents as e-mail� 
�

Sending, objects to the back� ���

Setting
advanced shape field options� ���

bullet styles for text� ���

default number format for new shapes� ��


defaults for arrowheads� ���
 261



Home Index Previous Page Next Page
iGrafx
S Y S T E M
numbering position in shapes� ���

text defaults� ���

text orientation� ��


text orientation for shape fields� ���

Shadows
adding to shapes� ���

changing directions� ���

coloring� ��


indicators� ��

Shape field descriptions, including with shapes� ��	

Shape fields, setting text orientation� ���

Shape Library
adding shapes to� ���

arranging shapes in� ���

duplicating shapes in� ���

editing shapes in� ���

placing shapes using� ��	

removing shapes from� ���

setting defaults in� ��������

using� ���

Shape numbers
showing on all shapes� ���

showing on selected shapes� ���

Shape text, creating� ���

Shapes
activating links to� ���

adding advanced data options� ���

adding advanced link settings� ��	
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adding color, pattern, or gradient to fill� ���

adding data fields� ���

adding fields to� ���

adding preset shape styles� �	�

adding secondary text areas� ���

adding shadow or 3D effects to� ���

adding to the Shape Library� ���

adding to the Toolbox toolbar� ���

arranging in the Shape Library� ���
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1. GRANT OF LICENSE. This License is granted to you in consideration for full payment of all fees associated with the Micrografx software (hereinafter referred to as "the Software'")
in accordance with the terms defined by Micrografx, the Software dealer, or on the site allowing for the downloading of the Software. The License permits you to use one copy of th
Software on any single computer If the Software is permanently installed on the hard disk or other storage device of a computer, then the person authorized to use such computer als
may use the Software on a portable computer, laptop or home computer so long as the Software is not used on both computers at the same time. If such person's authorization to use
such computer ceases for any reason (e.g. termination of employment), then such person's authority to use the software on a portable computer, laptop and home computer will cease
The Software is licensed as a single unit, and its component programs may not be separated for use on different computers. You must acquire and dedicate a license for each separa
computer on which the Software is installed or run from the storage device. A License for the Software may not be shared or used concurrently on different computers. Installation and
or usage on a network server requires a License for every user who accesses the Software at any time.

2. OWNERSHIP. Title, ownership rights, and intellectual property rights in and to the Software will remain in Micrografx and is protected by United States copyright laws and 
international treaty provisions. There is no transfer to you of any title to or ownership of the Software and this License should not be construed as a sale of any right in the Software
You must treat the Software like any other copyrighted materials, except that you may either (a) make one copy of the Software solely for backup or archival purposes, or (b) transfe
the Software to a single hard disk provided you keep the original solely for backup or archival purposes. You may not copy written materials accompanying the Software. You may us
the Software in your own personal and business documents as long as you are not selling the output generated by the Software or any related services. You may modify the Software
and/or merge it into another computer program to the extent necessary for your own use on the network or computer, but any portion of the Software merged into another computer 
program will continue to be subject to this License.

3. UPGRADES. If the Software is labeled as an upgrade, you must be properly licensed to use a product identified by Micrografx as being eligible for the upgrade in order to use the
Software. The Software labeled an "upgrade" replaces and/or supplements the product that formed the basis for your eligibility for the upgrade. The upgrade may not be separated f
use from the product, or transferred separately or used on more than one computer except as set forth above.

4. OTHER RESTRICTIONS. This License, delivered with the Software or which may be printed from the web site allowing for the downloading of the Software is your proof of license 
to exercise the rights granted herein and must be retained by you. You may not rent or lease the Software, but you may transfer your rights under this License on a permanent basis 
provided that you transfer this License, the Software and all accompanying written materials, you retain no copies, and the recipient agrees to the terms of this License. You may no
translate, decompile, or disassemble the Software or make any attempt to discover the source code to the Software. If the Software is an update, any transfer must include the updat
and all prior versions. Further, you may not place the Software onto a server so that it is accessible via a public network such as the Internet.

5. MULTIPLE MEDIA. You may receive the Software in more than one medium. Regardless of the type or size of the medium you receive, you may use only the media appropriate
for your single designated computer or network server. You may not use any other media on another computer or computer network, or loan, rent, lease, or transfer them to another 
user except as part of a transfer or other use expressly permitted by this License.

6. LIMITED WARRANTY. MICROGRAFX WARRANTS THAT THE SOFTWARE WILL PERFORM SUBSTANTIALLY ACCORDING TO THE WRITTEN MATERIALS 
DELIVERED WITH THE SOFTWARE, WHICH MAY BE PRINTED OR DOWNLOADED, FOR NINETY (90) DAYS FROM THE DATE OF ORIGINAL PURCHASE. 
MICROGRAFX DISCLAIMS ALL OTHER WARRANTIES, EITHER EXPRESS OR IMPLIED (INCLUDING WITHOUT LIMITATION, IMPLIED WARRANTIES OR 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE) CONCERNING THIS SOFTWARE AND ITS ACCOMPANYING WRITTEN MATERIALS. Some 
jurisdictions do not allow limitations on duration of an implied warranty, so the above limitation may not apply to you. This limited warranty gives you specific legal rights. You may
have others which vary by jurisdiction.

7. REMEDIES. Micrografx's entire liability and your exclusive remedy will be replacement of the Software by Micrografx that does not meet Micrografx's Limited Warranty. For this 
purpose, you shall, with respect to Software delivered on tangible media, return the Software and the written materials to Micrografx or the place from which it was purchased with a
copy of your receipt; with respect to Software which may be downloaded, contact Micrografx or your dealer directly. This Limited Warranty is void if failure of the Software has 
resulted from accident, abuse, or misapplication. Any replacement Software will be warranted for the remainder of the original warranty period or thirty (30) days, whichever is longer.

8.  LIMITATION OF LIABILITY. In no event will Micrografx or its suppliers be liable for any damages whatsoever (including, without limitation, damages for loss of business profits,
business interruption, loss of business information, or other pecuniary loss) arising out of the use of or inability to use the Software, even if Micrografx has been advised of the possibilit
of such damages. More specifically, Micrografx will not be liable for the technical procedure for the downloading of the Software. Because some states do not allow the exclusion o
limitations of consequential or incidental damages, the above limitations may not apply to you.

9. EXPORT RESTRICTIONS. You may not export or reexport the Software or any underlying information or technology except in full compliance with all United States and other 
applicable laws and regulations.

10. U.S. GOVERNMENT RESTRICTED RIGHTS The Software and documentation are provided with RESTRICTED RIGHTS. Use, duplication, or disclosure by the government is 
subject to restrictions as set forth in subparagraph (c) (1) (ii) of the Rights in Technical Data and Computer Software clause as DFARS 252.227-7013 or subparagraphs (c) (1), and (



on 
of the Commercial Computer Software-Restricted Rights at 48 CFR 52.227-19, as applicable, and any amendments thereto.

11.   MISCELLANEOUS PROVISIONS. This License is governed by the laws of the State of Texas, USA (and not by the 1980 United Nations Convention on Contracts for the 
International Sale of Goods, as amended). This is the entire agreement between us relating to the Software and supersedes any purchase order, communication, advertising, or 
representation concerning the Software. No change or modification of this License will be valid unless it is in writing and is signed by an authorized representative of Micrografx. If 
this Software was acquired outside the United States, then local law may apply. If you acquired this Software in Canada, you agree to the following:

The parties to this License have expressly required that the License be drawn up in the English language./ Les parties aux présentes ont expressement exigé que la présente conventi
soit rédigée en langue anglaise.

Copyright © May 2000 by Micrografx, Inc.
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